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This guide is for:

♦ new users

♦ experienced AS/400 users who want to access their reporting
software via Microsoft Windows, and

♦ anyone wanting to use the ease of Windows, Win95 or WindowsNT
to create reports from their AS/400 data.

Use this guide to get the best results from Jacana. It provides clear
instructions on how to achieve the results you want.

V GXQd�Yd�S_fUbc

This guide is designed to help you to learn how to use Jacana as
quickly and as easily as possible. The guide focuses on the following
tasks:

♦ installing Jacana

♦ setting up Jacana

♦ getting used to Jacana

♦ using Jacana to create new report definitions

♦ using Jacana to modify existing report definitions.

♦ learning how to use Jacana by doing the Hands-on exercises.

V GXQd�Yd�T_Uc�^_d�S_fUb

This guide does not provide details on how to use Microsoft Windows or
your AS/400 reporting software. For details on these refer to the
documentation that came with these products.



:QSQ^Q
1R_ed dXYc WeYTU

@QWU :�" :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

V 8_g�d_�ecU�dXYc�WeYTU

This guide is designed to help you use Jacana as quickly and as easily
as possible. It provides clear instructions on how to achieve the results
you want from Jacana. It has been designed so it can ‘live’ on your desk
and always be at hand. This means you can quickly turn to the
information you need without wasting any time.

This guide has several sections. These are:

Reporting fundamentals is an introduction to the basic concepts of
reporting, the use of databases and Jacana.

What is Jacana? is an introduction to Jacana.

Preparing for installation covers administrative information for Jacana
including system requirements and licensing of Jacana.

Preparing for installation covers how to install and setup Jacana on
your PC.

All about Jacana covers the Jacana screen, the menus, toolbars and
buttons you use in Jacana.

Using Jacana - an introduction provides detailed instructions on how
to use Jacana. This section covers how to start and exit Jacana. It also
covers the extra mouse functions in Jacana.

Using Jacana - Basic tasks provides detailed instructions on how to
achieve the major tasks. This section covers creating and modifying
report definitions, adding data to your report definitions and designing
the report layout.

Using Jacana - Advanced tasks provides detailed instructions on how
to perform advanced tasks. These include filtering data fields, changing
output devices, changing the server and editing run-time interface text.

Trouble-shooting to help you solve problems you might have.

Hands-on exercises to help you learn more about Jacana.

The guide has a Table of Contents and an Index. Use these to find a
topic or task you want information about.
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These following conventions are used in this guide to identify special
names or text:

Bold type indicates menu names, button names and function keys.

Italic type indicates titles of sections of the guide. It is also used to
indicate text that you are to type (such as in the Hands-on exercises).

µ Tip: indicates additional information or short-cuts that you might
find useful.

√ Indicates actions you are to do.

� Indicates warnings and special precautions.

V >UUT�XU\`/

You can find information about Jacana either in this guide or by using
the on-line help.

For information on how to use Microsoft Windows or your AS/400
reporting software refer to the documentation that came with these
products or any on-line help that may be available.

?^�\Y^U�XU\`

Much of the information that appears in this book is also available as
on-line help. You can use the on-line help by:

♦ choosing the Help menu from the menu bar

♦ clicking on the Help button on the toolbar and then clicking on the
command, tool, screen region or item you want information about

♦ clicking on the Help button shown in certain dialog boxes

 ♦ pressing F1

 ♦ double-clicking on the status line.

♦ Click the More About button to show more information for a
selected item, such as a report, data source or calculation function.
More About information may be added locally or supplied with the
server product.
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The essential ingredient for many businesses is information. They
accumulate large quantities of data then extract the detailed
information they require from this data.

4QdQRQcUc

These large accumulations of data are normally stored on computers,
structured into databases. What is a database? A database is a
collection of related pieces of data. For example, an address book is a
basic database, storing data about friends, colleagues, organizations,
companies, etc.

Name Address City Zip Phone Birthday

Andrew (H) 1 Connaught Rd Madison Mills, Va. 22953 223 9230 10 March, 1967

Andrew (W) 32 Market St Arlington, Va. 22203 686 3245

CMS Inc. 56 Bridge Street Portland, Or. 97225 (503) 203 6732

Darren
Edwards

24 Ash Street Winnipeg, Manitoba R2Y 2K2 (204) 888 5425 13 June, 1968

Michael
Hanratty

830 E. Cody Everett, Wa. 78203 23 August 1972

In database terms, each piece of data (address, city, phone, etc.) is a
field and each associated set of fields is a record. The separate entries
for (H)ome and (W)ork would be individual records, although they are
for the same person. The complete address book, since all its records
have similar data is a file. Copies of correspondence,
Personal/Business, Received/Sent kept for reference, is another file
familiar to everybody.
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An address book is arranged to let you easily find the information that
you need, providing you know the person’s name. However, this
sequence would be inconvenient if you wanted to know all the people
with a birthday next month. In this case you would need to read every
entry.

An address book is an example of a basic, single file database. Since
many of the letters (records) in the correspondence files can be
associated to a name/address in the address book, these files could be
considered part of the same database.

8_g�TQdQ�Yc�cd_bUT�_^�S_]`edUbc

Computers store data in files. Each database file consists of a collection
of related fields arranged into a table structure, as illustrated in the
address book earlier. Each column is a field - holding only one kind of
information, e.g. zip code. Each row is a record - holding a set of
directly related fields, e.g. name, address, birthday, etc.

Associated with every file there is a set of attributes identifying it and
defining its contents.

1ddbYRedUc�_V�Q�TQdQRQcU�VY\U

♦ Library identifier. The disk space on a computer can contain vast
numbers of files. The library is a means of grouping files allowing
for easier location and retrieval.

♦ File identifier. Each file within a library is referenced with a unique
identifier, e.g. DFB01.

♦ File description. Text that describes the data contained within a
file, e.g. “Address information”.

♦ Fields. Each file has one or more fields, e.g. an address file may
include the fields such as:

» name

» line 1 of postal address

» line 2 of postal address

» zip code

♦ Keys. Key fields are the means of identifying records of data held on
a file, e.g. name.



:QSQ^Q
BU`_bdY^W Ve^TQ]U^dQ\c

@QWU :�& :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

Each field in a file, like the file itself, has a set of attributes identifying
it and defining its contents.

1ddbYRedUc�_V�TQdQRQcU�VYU\Tc

The attributes present might include such things as:

♦ Descriptors. For instance, Column Headings, Description and
Labels.

♦ Data type. Describing the type of symbols or characters the field
may hold.

» Numeric - the field can only contain numbers, e.g. a field
Quantity on Hand may only hold a count of an item in stock.

» Alphanumeric - the field can contain any symbols (numbers,
letters and special characters such as commas, etc.), e.g. an
Address field may contain any numbers and letters.

♦ Field size. This indicates the number of characters the field can
hold. The field will always be full of characters, e.g. a Name field
could be 30 characters long, if you type “IBM” into such a field, the
remaining character positions contain the invisible character blank.

4QdQ�Q^T�Y^V_b]QdY_^

Databases on computers may comprise hundreds, even thousands of
files. Each file may have dozens or hundreds of fields, with some files
involving thousands, often millions of records. This volume of data is
unmanageable at an individual record level, unless there is some
means of isolating from the mass of data the information that is
required. Maybe this information is exceptions, e.g. overdue debtors,
stock items requiring reorder, etc. At other times it may be
summarized information that is needed, e.g. total sales of an item
across all stores, the maximum, minimum and average daily sales for
each store in a given week, etc. The means of transforming data into
information is reporting.
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Reporting is the means of isolating and presenting the information
required from the data available. Using a reporting solution such as
Jacana, you specify what data you need to produce a report containing
only the important, meaningful information that you require. This
process comprises some or all of the following steps.

♦ Identifying the data source. Which file(s) or set of files contain the
required data?

♦ Choosing the fields. Which fields from these files need to be used for
any reason in the report?

♦ Selecting. Which records of data are needed?

♦ Sorting. If the records are not sorted (or sequenced) into the order
that you require they may be presented in an order of little
meaning or use to you. Also, sorting may be required for creating
totals.

♦ Totaling. Combining data from several records into a single value
by means of totals, counts, averages, etc.

♦ Designing the layout. Organizing the data for presentation.

♦ Calculating. Sometimes the raw data in the files needs
transforming to be presented as information in your report.
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Jacana is a Windows-based program that allows you to create and
modify AS/400 reports from your PC. It acts as a client to AS/400
server products such as OPEN/DB, Info WorkPlace, MIDAS/Q and
SYNON/RW.

Using Jacana you can:

♦ design new report definitions

♦ modify existing report definitions

♦ store your report definitions locally (on your PC) for future use.

 You can rapidly create a new report definition from scratch, or base it
on an existing one. ReportWizards can help you create a report
definition quickly and easily.

 You do not need specialized knowledge of the database, its structure,
files or keys. You do not need technical knowledge to perform complex
data manipulation. Jacana has tools to perform many functions
including totals, subtotals, averages and other data manipulation
actions for your reports.

 Jacana gives you full access to your AS/400 server product’s reporting
capabilities from your PC. This gives you the power, security and
sophistication of your AS/400 and its software, combined with the ease-
of-use of the Windows environment allowing you to easily create and
modify report definitions, while retaining the benefits of the AS/400
where the reports are actually run. This ensures:

♦ file linking and joins are correct

♦ users cannot create superfluous and resource-hungry logical views

♦ accurate automatic measuring of report times, usage and report
definitions

♦ optimized performance of compiled programs

♦ no reliance on ODBC drivers or SQL

♦ large volumes of data can be rapidly processed, and

♦ systems resources are fully managed.

 The diagram below shows what happens on each computer.
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 Jacana enables you to use the data on your AS/400. The quality of this
data and the quality of the information interface are crucial to how
much you can get out of Jacana.

� Some of the sophisticated report layouts created or modified
using Jacana may contain features that cannot be replicated
on a server product “green screen”. If the “green screen”
Quick function is used to attempt a report redesign, a
warning is displayed. This warning says that the existing
layout will be changed. The warning has an option to allow
you to abandon the layout redesign. Using a server “green
screen”, it may not be possible to exactly recreate a layout
designed using Jacana.

V 4UVY^YdY_^c

There are a few terms used in this guide that you should know about.

4QdQ�c_ebSU

The term ‘data source’ refers to the server (AS/400) database file or
subset you are using. The data source is defined on the server, but a
copy may be saved locally (on your PC).
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The term ‘parameter’ refers to a constant value supplied by the user
who initiates a report run. It is defined within the Report
Specifications and can be used in various ways (e.g., calculations,
conditions). It can also be printed anywhere in the report layout.

@YS[Y^W�\Ycd�G_b[Y^W�\Ycd

The term ‘picking list’ refers to the list of available fields from the data
source.

The term ‘working list’ refers to the list of fields currently used in the
report definition. A working list is made up of the fields used in any
part of the report definition. These can be fields used in specifications,
fields dragged into the report and fields that you chose from the picking
list by using the checkbox.

You can choose which list is shown in the DataCrafter.

@b_`UbdYUc

The term ‘properties’ refers to the attributes or settings of an item in
Jacana. You can set properties for:

♦ individual fields (field properties)

♦ individual lines in a report layout (line properties)

♦ a report section (sheet properties), and

♦ the entire report (report properties).

BU`_bd

The term ‘report’ refers not only to printed output - it also applies to
output designed for workstations or file output. You can choose the
output medium you require and tailor your report for that medium.

CXUUd

Jacana supports multi-sheet reports. A report sheet determines the
overall look of a section of a report or output. For example, a report
could have a detail sheet and a summary sheet.

CeRcUd

The term ‘subset’ refers to a portion of the server database that you can
access. A subset is defined in the server product.
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This section contains information on how to prepare for Jacana installs,
including:

♦ What steps to do on the server product

♦ Preparing Jacana installation diskettes.

▼ ?^�dXU�cUbfUb�`b_TeSd

♦ When you INSTALL or UPGRADE the server product on the
AS/400 make sure you choose to restore client install objects. Part
of this step includes creating an AS/400 folder. The default name for
this folder is /QDLS/<product>/INSTALL, with sub-folders for
JACANA, and VALET.

♦ Ensure that your users are authorized to the AS/400 folders in the
above step. A default install will grant *PUBLIC access to these
folders.

♦ Ensure the server product has the Common product library set (See
Client information option in the Global Settings function on the
server product).

♦ License the server product for Jacana.

▼ <YSU^cY^W�:QSQ^Q

 Jacana can be installed on PCs not connected to a compatible AS/400
server product, for demonstration, education or similar purposes. In
such cases Jacana is fully functional but cannot receive from or save to
the server product. Any attempt to communicate with an unlicensed
server product will be unsuccessful and an appropriate message will be
shown.
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 For Jacana to operate with your AS/400 server product there must be a
valid Jacana license in the target AS/400 product. This license will
allow Jacana, installed on any number of PCs connected to that
AS/400, to operate in client/server mode. In this mode it will make full
use of the controlled environment and data that the server product
makes available.

 Any licensed Jacana installation can, in the course of a client/server
session, have required data source information downloaded to it from
the server product. This copy of the data source can be saved locally on
the PC. Later, when not connected to the server, this local copy can be
used to develop report definitions. Of course, the report definitions
must be transferred to the same server product library before they can
be used to generate output.

 To apply a Jacana license to the AS/400 server product, use the
$$LICENSE command in that product.

▼ 3_]]e^YSQdY_^c

Jacana communicates with the server product via either

♦ APPC

♦ CPI-C

♦ TCP/IP.

The APPC and CPI-C options require Client Access/400 to be installed
on both the AS/400 and each PC workstation.

When using TCP/IP, make sure:

♦ You set up AS/400 connections using menu item L Connect from
the Jacana menu. 

♦ The TCP/IP monitor is started on the server product before starting
Jacana (see Client/Server contents and installation guide).

In any option, make sure:

♦ that the necessary hardware network connections (e.g. twinax,
Ethernet) exist between the AS/400 and the PC workstations, and

♦ The appropriate network options are configured on the PC
workstations.
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Jacana requires the following hardware and software resources.

@3�XQbTgQbU

At a minimum, your PC should have:

♦ a 486 processor

♦ 16 MB of RAM

♦ 8 MB of free hard disk space for the Jacana software

♦ additional hard disk space is required for saving report definitions
on your PC

♦ A communication adapter connecting your PC to your AS/400. For
example, Twinax, Ethernet or Token Ring connection under the
Client Access router.

 @3�c_VdgQbU

♦ Microsoft Windows NT or

♦ Microsoft Windows 95

♦ Microsoft Windows 98.

 If using APPC or CPIC communications protocol, you will also need:

♦ Client Access Version 3 or later.

 1C�$  �c_VdgQbU

♦ OS/400 V3R1M0 or later.

♦ Server product internal level 070 or later.
Note: To check the internal level number on your server product,
choose the Global Settings menu option and read the release/level
number on the screen.
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Installing Jacana is an easy process that takes approximately five
minutes.

9^cdQ\\Y^W�ecY^W�Q�]Q``UT�^Udg_b[�V_\TUb

 To install Jacana:

√ Check that you have no other applications running.

√ Using Explorer, map a network drive to the AS/400 folder for
installing Jacana. By default this is
\\<AS400>\qdls\<product>\install\jacana
where:
<AS400> is the name of your AS/400, and
<product> is the name you specified when you installed the client
install objects on the server product.

� The InstallShield will not work with Client Access/400
shared folders unless you use the map network drive
facility.

µ Your administrator may have created an install set on a PC
network server.

√ Open the folder Disk1.

√ Double click on the file setup.exe. The Jacana setup program starts.

√ Follow the instruction in the setup wizard.

 When you have finished installing Jacana you will see that your
Window’s Start menu has been modified. You will see:

♦ A new menu item has been added to the Programs menu.

♦ Jacana has been added to the new menu item.

♦ Items have been added to the Jacana menu. The items added will
depend on the choices made in the setup wizard.

9^cdQ\\Y^W�ecY^W�TYc[UddUc

 To install Jacana:

√ Check that you have no other applications running.
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√ Insert the Jacana Installation Disk 1 into your floppy disk drive,
usually drive A.

√ Choose Run from the Start menu.

√ Type a:\setup in the dialog box and click OK. The Jacana setup
program starts.

√ Follow the instruction in the setup wizard.

 When you have finished installing Jacana you will see that your
Window’s Start menu has been modified. You will see:

♦ A new menu item has been added to the Programs menu.

♦ Jacana has been added to the new menu item.

♦ Items have been added to the Jacana menu. The items added will
depend on the choices made in the setup wizard.

CUde`�di`Uc

 Jacana offers alternate setup types. By not installing certain
components, you can save disk space. If you are not sure which option
to use, choose Typical.

 Di`YSQ\

 This option will install:

♦ Jacana

♦ Jacana on-line help

♦ Support for TCP/IP connections

♦ Jacana exercises.

 3_]`QSd

 This option will install:

♦ Jacana.

 3ecd_]

 This option will allow you to install Jacana and optionally:

♦ Jacana on-line help

♦ Support for TCP/IP connections
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♦ Jacana exercises

♦ Jacana Administrator

♦ Jacana Administrator on-line help.

When this option is selected, the default is for a complete installation.
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This section describes the Jacana screen, menus, toolbars and buttons.

V DXU�:QSQ^Q�gY^T_g

Jacana is a Windows-based product. This means it works in much the
same way as all your other Windows programs. You can choose
functions or tools by using either the buttons on the toolbars or by
choosing from the menus.

The following illustration identifies each part of the Jacana window.

Menu bar

Ruler

Standard
toolbar

Layout
window

DataCrafter

Layout
toolbar

Status bar
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Jacana shows your report definition in the layout window. Use the
layout toolbar and/or the menu options to refine the layout of your
report. Add fields to your report definition simply by dragging them
from the DataCrafter into the report layout.

Use the scroll bars to move around the report definition. Alternatively,
use the arrow keys to move the cursor in the report definition.

Jacana lets you have multiple report definitions open at any one time.

You can arrange your report definition layouts in various ways. They
can be cascaded down the layout window or tiled across it. A report
layout can also be split, both horizontally and vertically. Report layouts
can also be minimized as icons in the layout window.

DXU�4QdQ3bQVdUb

The DataCrafter allows you to filter, select and view your fields. Along
the top of the DataCrafter is the data toolbar. This has buttons that let
you select which field list is shown, filter the fields and view the
properties and source of any field.

To add fields to your report definition simply drag them from the
DataCrafter into the report layout.

In the lower portion of the DataCrafter the fields available in your
current data source are shown, being either the working list of fields or
the picking list. The picking list can show all the fields in the data
source and is the list of fields you can pick to use, the working list
shows the fields currently used in the report definition. Use the toolbar
to choose which field list is shown.

For each field listed there is a checkbox, the field name and a
description of the field. The checkbox indicates if this field is already
being used in the report definition.

You can change the size of the DataCrafter. Move the cursor over the
top edge of the DataCrafter, the cursor changes to a double-headed
arrow. Click and drag to re-size the DataCrafter.

You can also move the DataCrafter around your screen. Simply click on
the border and drag it into the new position. In fact by using the
Toolbars option from the View menu you can turn the DataCrafter off
and on.
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Jacana’s status bar along the bottom of the window lets you know what
is happening. Jacana displays messages, for instance what the
particular toolbar button does, and a progress bar for longer tasks. The
status bar may show other information, according to user options,
which include:

♦ if you have chosen to overtype, i.e. what you type replaces the
information shown in the report definition

♦ if you are viewing a read-only file

♦ communications status.

 Some indicators shown in the status bar may be toggled on or off by
double-clicking with the mouse. For example

♦ overtype

♦ read only

♦ caps lock

♦ number lock

The last two numbers on the status bar are the current coordinates of
the insertion point. They show what line and character the insertion
point is at in the report definition shown in the layout window.

To turn off the status bar use the Status bar option from the View
menu.

Be\Ub

You can have a ruler shown along the top of your layout window. The
ruler measures the number of characters across the report. The marker
in the ruler bar shows where the cursor is in the current line of the
report. You can use this marker to help align items in your layout. If
you click on the ruler it shows a vertical line down the layout window,
this can also help you to align things in your report layout.

To turn the ruler on or off, choose the Ruler option from the View
menu.
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Jacana gives you several ways to choose commands. You can select the
options you want from the menus, use the shortcut menus or click
toolbar buttons with the mouse. Jacana has four toolbars:

♦ standard toolbar

♦ layout toolbar

♦ data toolbar, and

♦ sheet toolbar.

The standard toolbar is always available and is usually shown at the
top of the Jacana window. The layout and data toolbars are available
when you are using report layout and the DataCrafter respectively.
The layout toolbar changes depending on whether you are using the
page layout view or the record layout view. The sheet toolbar is not
shown by default, but may be useful when using multi-sheet reports.
All Jacana toolbar commands are also available from the menus.
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This toolbar lets you perform the most common functions with a single
click of the mouse. Just click on the button to do the following actions.

Create a new report definition.

Open an existing report definition.

Save the active report definition.

Run the active report definition. This option is only available if
Valet is installed on your computer.

Print the active report definition.

Preview how the report definition would appear on your printer.

Cut selection from Layout to clipboard.

Copy selection from Layout to clipboard.

Paste selection from clipboard to Layout.

Undo report changes.

Redo undone actions.

See the properties of the active report definition.

See the specifications for the active report definition.

See the run-time interface text. This is the text displayed on the
AS/400 asking for select/omit and parameter values at run-time.

See list of sheets for the report.

Get context-sensitive help about using Jacana. This is help
about the item you then click on.
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This toolbar lets you perform the major layout functions with a single
mouse click. It shows the status of the current line in the report layout
and allows you to change the characteristics of this line.

See the attributes of the current line.
Blank lines shown in the layout may have no line type. These are
spacing lines shown when the View Image option from the
Image menu has the Show line spacing option checked.
If the current line is a blank space line you can convert it into an
empty print line.
Empty lines are not printed when the report is run.

Choose and change a line type for the current line.

Set the page line number that this report line is printed on.

Set how many blank spacing lines there are before the current
line.

Set how many blank spacing lines there are after the current line

Insert an empty line after the current line, of the same line type.

Insert an empty line before the current line, of the same line
type.

Delete the current line.

Toggle the bold attribute on or off for the current field or line
(field if cursor is in field, otherwise line).

Toggle the underline attribute on or off for the current field or
line (field if cursor is in field, otherwise line).

See the output settings.

See the properties and output settings for the current layout
sheet.
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This toolbar lets you perform the major record layout functions with a
single mouse click.

Choose if detailed or summarized data will be
output.

Choose how the report output should be formatted
for use by PC-based applications.

Move the current field up the list of chosen output
fields.

Move the current field down the list of chosen
output fields.

Delete the current field from the list of chosen
output fields.

Set the output settings.

See the properties and output settings for the
current layout sheet.

CXUUd�d__\RQb

This toolbar is useful when working with multi-sheet reports.

Add a new sheet to the report.

Choose which report sheet to display.

Toggle the null report sheet setting. If this button
is down, this sheet will be output if no data chosen
when the report runs.

Delete the current sheet.
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The data toolbar is part of the DataCrafter. This toolbar lets you work
with the available lists of fields with a single mouse click. Just click on
the button to do the following actions.

See the working list of fields.

See the picking list of fields.

Define the criteria for filtering fields into the picking list.

Pick fields containing specified string. This is a shortcut to the
long text option of the filter picking list dialog.

See only the summary fields in the DataCrafter.

See summary fields by type and/or sort level.

See only the calculated fields in the DataCrafter.

See only the fields used for selections in the DataCrafter.

See only the fields used for matrix columns in the DataCrafter.

See only the parameters in the DataCrafter.

See only standard fields in the DataCrafter. Standard fields are
common to all data sources and include fields such as page
number and report name.

See the properties of the field highlighted in the DataCrafter.

See more about the field highlighted in the DataCrafter.

See the source of the data for the report.
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You can decide which toolbars are shown and where they appear. Move
the cursor to any toolbar and click the right mouse button or choose
Toolbars from the View menu, Jacana shows the Toolbars dialog box.

Use this dialog box to:

♦ choose which toolbars to see,

♦ where toolbars appear,

♦ the appearance of the buttons on the toolbars, and

♦ decide if Tool Tips are to be shown.

 To change the location of a toolbar:

√ Select the toolbar in the toolbar list

√ Click on a location option.

µ You can also move a toolbar to any location by simply clicking on it
and dragging it to the new location.
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Jacana commands are grouped on menus. Each menu contains a group
of related commands. The menus available are:

♦ File

♦ Edit

♦ View

♦ Report

♦ Layout

♦ Data

♦ Tools

♦ Window, and

♦ Help.

Each of these menus lists commands or functions related to that area.
For example, the File menu has commands to open, create, save and
print your report definitions.

6Y\U�]U^e

This menu allows you to do the major file actions, e.g. opening, saving
and printing your report definitions. Select the option you require to
perform the following functions.
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New Create a new report definition.

Open Open an existing report definition.

Server Choose a new AS/400 server to connect to. You can
choose the system and library you want to use.
Note. This option is only shown when no report
definitions are open.

Close Close the active report definition.
If you have any unsaved changes, Jacana asks if
you want to save them.

Save Save the active report definition.

Save As Save the active report definition with a new name.
This leaves the existing report as it was.

Run Run the current report. This option is only
available if Valet is installed on your computer.

Diagnostics Display errors or warnings that may prevent the
report from running correctly.

Print Print the report definition.

Print preview See how the report definition would appear on
your printer.

Print setup Setup your printer.
This is for your Windows printer to print the
report definition, not your AS/400’s printer.

(Recent
reports)

Jacana lists the names of the last few report
definitions you have used. Choose one to re-open
that report definition.

Exit Exit from Jacana.
If you have any unsaved changes, Jacana asks if
you want to save them.
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This menu allows you to do some editing functions, e.g. switching
between overtype and insert modes. Select the option you require to
perform the following functions.

Undo Use this option to reverse the last change to the
report.

Redo Use this option to re-apply an undone action.

Cut Use this option to remove parts of Layout. The
removed parts may then be used for a Paste
operation.

Copy Use this option to copy parts of Layout for a Paste
operation.

Paste Use this option to insert cut or copied parts of
layout using the default mode, i.e.:

Paste Insert Lines if whole lines were cut or
copied, or

Paste tracker or Paste immediate depending on
your preferences set in Options

Paste Special Use these options to insert cut or copied parts of
layout in one of three ways:

Paste tracker: The data is pasted using a two-
stage procedure. First move the insertion point
with the mouse or keyboard. Jacana shows an
outline of where the data will be pasted. When
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satisfied, either click with the mouse or press the
Enter key to complete the paste. Press escape to
avoid completing the operation.

Paste immediate: The data is pasted at the
insertion point. This method is more conventional,
but does not provide the visual feedback of the
tracker option.

Paste Insert Lines: The data is pasted on new
lines inserted before the insertion point.

Select All Use this option to select all lines in the layout.

Select Line Use this option to select the line indicated by the
insertion point.

Select Word Use this option to select the word or field indicated
by the insertion point.

Select Column Use this option to select the column (field plus
headings) indicated by the insertion point.

Extend
Selection

Use this option to toggle extended selection mode.

Overtype Use this option to toggle between over-typing and
text insertion in your report layout. Over-typing
means anything you type will type over the
existing material. Inserting text means your typing
is added to the report layout at the current cursor
location or insertion point.

Read only Use this option to toggle the read-only restriction
on or off for this file. This is intended as a warning
only.
The read-only ‘flag’ is set ‘on’ when you download a
report from the AS/400 and you do not have the
authority to change it. However, you can change
the read only setting (by using this menu option or
double-clicking on the indicator on the status bar)
and then save the report either to a different
AS/400 or by using the Save As option from the
File menu.

Empty Undo
Buffer

This option will clear the empty undo buffer. It
may be used to reduce the size reports before they
are saved.
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This menu allows you to set how Jacana looks on your screen. You can
specify the font used, whether the ruler, status bar and toolbars are
shown and how. Select the option you require to perform the following
functions. This menu changes, depending on whether you are in page
layout or record layout.

Font Choose or change the font for your report
definition to appear in Jacana.
Note, this is not the font in the actual report
created when you run the report on your AS/400.
It is the font Jacana uses for this report definition.
You cannot currently use Jacana to change the
font used on your AS/400.

Image Set how the report layout appears.
Jacana displays a dialog box in which you can
choose the number of report detail lines shown in
the layout window and whether line spacing and
page breaks are shown.

Background Choose or change the background of the layout
window. Setting the background makes it easier to
distinguish layout lines.
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Line types Show: Toggles on or off showing line types in the
margin of the layout window.

Small: Toggles on showing line types and sets the
size of the margin to small. When showing a small
margin, only a one or two letter abbreviation is
used for each line type, e.g. H=Page header,
S1=first sort break.

Medium: Toggles on showing line types and sets
the size of the margin to medium. When showing a
medium margin, a single word will be used for the
line type, e.g. Header=Page header, Sort(1)=first
sort break.

Large: Toggles on showing line types and sets the
size of the margin to large. When showing large
margins the full line type description is shown,
and sort lines show the name of the sort field
(Change of …).

Columns Set how the columns of the record layout are
displayed. Jacana displays a dialog box in which
you can choose which columns are displayed and
what order they are displayed.

Page Layout Display the layout view allowing you to work with
multiple lines.
Note: This will convert the report layout, re-
designing for output to printer, workstation or disk
with unstructured record formats. The existing
design of the report sheet will be lost.

Record Layout Display the layout view allowing you to work with
a single line.
Note: This will convert the report layout, re-
designing for output to disk with a structured
record format. The existing design of the report
sheet will be lost.

Full screen Toggle full screen mode. Full screen mode enlarges
the layout window to cover the entire screen. The
full screen allows you to see more of the report
layout without scrolling.
NOTE: Although the menu is not shown in full
screen mode, all menu options are available via the
keyboard shortcuts. E.g. Alt + F shows the file
menu.
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Ruler Toggle the ruler on or off.

Status bar Toggle the status bar on or off.

Toolbars Choose which toolbars are shown and where and
how they are displayed.

BU`_bd�]U^e

This menu gives you access to the commands that affect the whole
report. These include report sheet properties, the report properties
(appearance) and the major report specifications (content
specifications). You can also select the ReportWizard to help you to
quickly create a report based on your requirements. Select the option
you require to perform the following functions.

Sheets See and/or change the report sheets. You can
attach different banner and control pages and
specify output settings.

Properties See and/or change the properties for the report.
These include the report name, execution modes,
run-time statistics, data and AS/400 information
about the report.

Specifications See and/or change the specifications for the report.
Use the Specifications dialog box to access the field
specifications for the report. This includes
workfields, summary fields, page skips, run-time
selections and parameters.

Matrix
Columns

See and/or change the matrix column
specifications for the report.

Run-time
Interface

See and/or change the run-time interface text. This
is the text displayed when the report is run asking
for select/omit and parameter values.

ReportWizard Use this option to choose the ReportWizard to use
for this report definition.
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This menu allows you to work on the layout of your report definition,
e.g. you can insert fields, change the appearance of the current field or
line, select the line type, insert or delete lines. Select the option you
require to perform the following functions.

A number of these options apply to either the current field or line in
the report layout. If the cursor is in a field, the option applies only to
that field. If the cursor is in a line but not in a field, the option applies
to the entire line.

Bold Toggle the bold attribute on or off for the current
field or line (field if cursor is in field, otherwise
line).

Underline Toggle the underline attribute on or off for the
current field or line (field if cursor is in field,
otherwise line).

Insert field Insert a field into the layout.
Jacana shows a pop-up box. Enter the first
characters of the field you want. Press space or
Enter to accept the field or press Esc to cancel.

Change field Change (replace) the current field in the report
layout. Jacana shows a pop-up box with the
current field name. Enter the first character(s) of
the new field name, Jacana updates the field
name. Press space or Enter to accept the field or
press Esc to cancel.
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Format field See and/or change the formatting for the current
field.

Field
Properties

See and/or change the properties of the current
field, including type, size, description, data subset
and map.

Insert line Insert a blank line before or after the current line.
The new line is of the same line type.

Delete line Delete the current line.

Line
properties

See and/or change the line properties for the
current line. You can use this option to change the
attributes and conditioning of the line in the
report.

Resequence
lines

Resequence layout lines by line type.
Note: “Change of ...” lines before detail will remain
before detail lines and  “Change of ...” lines after
detail lines will remain after detail lines.

Output setup See and/or change the settings for the output
media specified in the report sheet.

Sheet
properties

See and/or change the current report sheet
properties. You can specify attributes, banner and
control pages and output settings.

LayoutWizard Apply a LayoutWizard to the current report
definition layout.

Convert to
Record Layout

Convert the report layout for output to disk with a
structured record format.
Note: The existing design of the report format will
be lost.
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This menu allows you to work on the disk output layout of your report
definition when the report output will use structured record formats,
e.g. you can insert, move or delete fields, and select detail or summary
level for output data. Select the option you require to perform the
following functions.

Insert field Insert the current field in the DataCrafter into the
disk output fields list.

Delete field Deletes the current field from the disk output
fields list.

Move field up Moves the current disk output field up the list.

Move field
down

Moves the current disk output field down the list.

Format field See and/or change the formatting for the current
disk output field.

Field
Properties

See and/or change the properties of the current
disk output field, including type, size, description,
data subset and map.

Output setup See and/or change the settings for the output
media specified in the report sheet.

Sheet
properties

See and/or change the current report sheet
properties. You can specify attributes, banner and
control pages and output settings.

LayoutWizard Apply a LayoutWizard to the current report sheet.
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Convert to
Page Layout

Convert the report layout, redesigned for output to
printer, workstation or to disk with unstructured
record formats.
Note: The existing design of the report sheet will
be lost.

4QdQ�]U^e

This menu allows you to work with the data in your report definition,
e.g. you can select which field list is shown in the DataCrafter, filter
the picking list, use QuickFilters, see the data properties, usage and
source and find a given field. Select the option you require to perform
the following functions.

Working list Show the working list of fields in the DataCrafter.

Picking list Show the picking list of fields in the DataCrafter.

Quick Filter Show either the summary fields, calculated fields,
fields used for selections, parameters or constants
in the DataCrafter.
For the summary fields you can select which
summary fields are shown in the DataCrafter.
For definition of constant fields, refer to Message
constants in your host product documentation.
Jacana currently supports the use of existing
constant fields defined in the report. However, you
cannot define constant fields from Jacana. Use the
host product to define a new constant field.

Filter picking
list

Define the criteria for filtering fields into the
picking list from the data source.

Source See information on the source of the data for the
report.
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This menu allows you to see and/or change various Jacana settings,
and use some products that complement Jacana. Other menu items
may be shown if the user has customized the user tools.

Options Show the Jacana Settings dialog box. The tabs on
this dialog box allow you to change screen
appearance, report design defaults and other
options.

Valet,
ValetMiner,
JacanaForms.

These menu options give access to various
products that complement Jacana, and will only be
shown if the Jacana settings indicate the products
are installed.

GY^T_g�]U^e

This menu allows you to control the various windows in Jacana, e.g.
you can arrange your report definitions, split the layout window, switch
between open report definitions and launch the specification dialog box.
Select the option you require to perform the following functions.

New window Open a new window with another copy of the
current report definition.

Cascade Re-arrange the report definitions on your screen.
Cascade arranges the report definitions to overlap
so that each title bar is visible.
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Tile Re-arrange the report definitions on your screen.
Tile arranges the report definitions in smaller
windows to fit next to each other.

Arrange icons Re-arrange any report icons. Jacana places the
report icons along the bottom of the layout
window.

Split Split the current report definition window. The
window can be split both horizontally and
vertically. Use the mouse or cursor keys to specify
where you want to split the screen. You can also
use the split bars (in the scroll bars) to create
horizontal or vertical splits.
To remove a split, drag the split ‘to the edge of the
window.

DataCrafter Move the cursor into the DataCrafter. If the
DataCrafter is turned off, Jacana displays it.
The check mark indicates that the DataCrafter is
visible.

Layout Bar Move the cursor into the layout toolbar. If the
layout toolbar is turned off, Jacana displays it.
The check mark indicates that the layout toolbar is
visible.

Specifications See and/or change the specifications for the report.
The check mark indicates that the Specifications
dialog box is visible.

Matrix
Columns

See and/or change the matrix columns
specification for the report. The check mark
indicates that the Matrix Columns dialog box is
visible.

Sheets toolbar Move the cursor into the sheets toolbar. If the
sheets toolbar is turned off, Jacana displays it.
The check mark indicates that the sheets toolbar is
visible

At the end of the Windows menu, Jacana lists the open report
definitions. Choose the report definition you want to work with. The
current report definition is indicated by a check mark.
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This menu lists the various on-line help options. You can see the Help
index, information on using the on-line help plus release and copyright
information about Jacana. Select the option you require to perform the
following functions.

Index See the on-line Help Index. This lists all the Help
topics available for Jacana.

Using help See information on how to use the on-line Help.

Tip of the Day See useful tips on how to use Jacana.

About Jacana See information about Jacana. This includes
release details, copyright and product information.

CX_bdSed�]U^ec

When you point to or choose some items in Jacana you can use a
shortcut menu. Shortcut menus contain commands related to the item
you’re working with. Shortcut menus are available in both the layout
window and the DataCrafter.

µ Click on the right mouse button to see a shortcut menu.

For example, if you point to a field in the Layout window and click on
the right mouse button, Jacana displays this shortcut menu.
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This section describes how to:

♦ start Jacana

♦ setup your AS/400 connection

♦ exit Jacana

♦ use the mouse for extra functions

♦ use the keyboard shortcuts.

V CdQbdY^W�:QSQ^Q

√ Use the Start button to choose menu item
Start\Programs\Momentum\Jacana\Jacana.

NOTE: The sub-menu Momentum may be different for private
label installations of Jacana.

√ Jacana starts and displays the Tip of the day dialog.
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√ Click on the Close button. Jacana displays the start dialog box.

√ Select the option you want to either create a new report definition
or open an existing report definition.
For further details on creating a new report definition, refer to the
Creating a new report definition section of this guide.

Jacana automatically connects to the last system and data library you
used.

CdQbdY^W�:QSQ^Q�V_b�dXU�VYbcd�dY]U

Jacana has to know which AS/400 system and which data library you
want to use. The first time you start Jacana, Jacana asks you to tell it
where to find your data.

µ Check which AS/400 system and data library you are connected to
before you start.
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 To set up Jacana:

√ Double-click on the Jacana icon. Jacana starts and displays the
Welcome to Jacana dialog box.

√ Click on the Next button to continue. Jacana displays the next
dialog box.

√ Choose Yes if you are connected to an AS/400
Choose No if you are not connected to an AS/400. Jacana stops the
setup process here. You can connect to your AS/400 at a later date.
For further information, refer to the Changing your server section of
this guide.
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√ Click on the Next button. Jacana displays the next dialog box.

√ Choose the protocol used for AS/400 communications. If you are
unsure which protocol should be used with your AS/400, contact
your network supervisor OR try each choice to establish which is
correct for your configuration.

√ Click on the Next button. Jacana checks your connection and
displays the next dialog box.

√ Choose the system you want to use from the drop-down list OR type
the name of a configured AS/400 system

√ Click on the Next button to continue.
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√ Enter the data library you want to use.

√ Click on the Next button to continue. Jacana connects to the
system and library you have chosen and displays the next dialog
box.

√ Click on the Finish button to complete setting up your system and
library settings.

The settings you have just created will remain as the default settings
until they are changed. Jacana will automatically use these settings
each time it is started.
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√ Choose Exit from the File menu to exit Jacana.
If there are any reports that you have created or changed and have
not already saved, Jacana asks if you want to save them.

V I_eb�]_ecU�

Jacana allows you to get more out of your mouse by giving power to the
right mouse button!

By clicking the right mouse button you can complete some functions
without having to move up to a toolbar or pull-down menu. These
include:

♦ using shortcut menus

♦ specifying how a field appears in your report layout or in the report
specifications dialog boxes.

For further information, refer to the Toolbars, buttons and menus,
Adding fields into your report definition and Refining your report -
contents sections of this guide.
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Jacana is designed so it can be used with or without a mouse or other
pointing device. Using the cursor keys, Tab key, Ctrl key and Alt key
(often when used with another key) you can still use Jacana to its full
extent.

Certain key combinations perform particular actions. These include the
following.

This key Does this

Insert Edit-Overtype

F1 Help

Shift+F1 Context Help

F5 Refresh layout view

Ctrl+F6 Next window

Shift+F6 Previous window

F8 Toggle Extended Selection mode

Shift+F8 Layout-Select Word

Shift+F10 Context menu
(equivalent to clicking on right mouse button)

Alt+0 Window-DataCrafter

Alt+1 Window-Layout window

Alt+2 Window-Specifications

Alt+3 Window-Matrix Columns

Alt+4 Window-Sheets Toolbar

& Insert field
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This key
with

CTRL
Selects this menu and
menu option

CTRL+SHIFT
Selects this menu and
menu option

Delete Layout-Delete Line

A Edit-Select All

B Layout-Bold

C Copy

F Layout-Field Properties Layout-Format Field

I Layout-Insert Line After Layout-Insert Line Before

L Layout-Line Properties

H Layout-Sheet Properties

N File-New

O File-Open

P File-Print

Q Layout-Resequence Lines

R Report-Properties

S File-Save

U Layout-Underline

V Edit-Paste

W Report-ReportWizard Layout-LayoutWizard

X Edit-Cut

Y Edit-Redo Multiple Edit-Redo dialog

Z Edit-Undo Multiple Edit-Undo dialog

The keyboard shortcuts are shown on the menu bar menus. However,
they are not shown on the shortcut menus.
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In addition, some other actions may be modified using keys as follows:

Action This key Does this

Save (  or menu) Shift Save As.

New calculation

 (  or option New
Calculation in
specifications short-
cut menu)

Shift Reverse default action. See
Show Calculation Builder
for new calculation setting
(see specifications tab in
options dialog).

Moving insertion
point in expressions

Alt Reverse default Auto-select
setting (see expressions tab in
in options dialog).



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

:QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

@QWU :�$)

W EcY^W�:QSQ^Q���2QcYS�dQc[c

This section describes how to:

♦ create a new report definition

♦ modify an existing report definition

♦ save a report definition

♦ choose fields to use in a report definition

♦ add and remove fields to a report definition

♦ add text to a report definition

♦ refine the content of a report

♦ refine the appearance of a report

♦ set the appearance of a report

♦ preview how a report definition layout would appear when printed.

V 7UddY^W�bUce\dc

To create a report definition you may not have to do all of these tasks.
Using a ReportWizard is often the fastest way to create your report
definition. The ReportWizard helps you create a report definition by
following a series of easy steps. You can then modify your report
definition as much as you want to suit your needs.

For further details on ReportWizard, refer to the Creating a new report
definition section below.

The ReportWizard is only one way Jacana has of letting you get on with
your work. Jacana also has LayoutWizard and QuickFilters. You can
use these whenever you are working on a report definition.

LayoutWizard helps you speed up the layout of your report. You can
quickly choose or change how your report will appear. For further
details on LayoutWizards, refer to the Refining your report -
appearance section of this guide.

QuickFilters let you choose the types of fields you see in the
DataCrafter. For further details on QuickFilters, refer to the Using
filters section of this guide.
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When you create a new report definition, you must specify both the
content and the layout of the report. That is, you have to define what is
in the report and where and how it is shown.

There are three ways to create a new report definition. You can create
a report definition by using:

♦ a ReportWizard

♦ an existing report, or

♦ a data source, such as a data subset or database file.

 The ReportWizard displays a series of dialog boxes that lead you
through the steps in creating the report definition you really want.

 Choose an existing report as the base to create a new report definition.
This is useful when you need to create a new report definition that is
very similar to an existing report definition.

 Choose a blank report using data from a subset or file to create a new
report definition. This option gives the most flexibility but also requires
you to make more decisions on report content and layout.

µ Use a ReportWizard to quickly create your report definition.

EcY^W�Q�BU`_bdGYjQbT

To create a new report definition:

√ Click on the New button or choose New from the File menu.
Jacana displays the New Report dialog box.
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√ Choose the ReportWizard option.
Jacana displays either:

♦ the first ReportWizard dialog box, or

♦ the Choose Wizard dialog box.

µ The Choose Wizard dialog is shown only if more than one Wizard is
available, and the Always use default ReportWizard option is
NOT set.

√ The ReportWizard leads you through a series of dialog boxes. These
ask you questions about what information you want in your report
definition and how you want that information laid out.

√ Click on the Finish button when you are satisfied with the settings
you have entered. The ReportWizard will now create your report
definition based on your answers.

√ You can now modify your report if you want to.

√ Remember to Save your new report definition.

EcY^W�Q^�UhYcdY^W�bU`_bd�TUVY^YdY_^

To create a new report definition from an existing report definition:

√ Click on the New button or choose New from the File menu.
Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

.
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√ Choose a recently used report definition from the drop-down list box
or click on the Choose Report button to see the Choose Report
dialog box.

√ Choose either the Local or AS/400 tab depending on where the
existing report definition is.

√ If you choose a report on your PC, check the disk drive and
directory are correct and choose the report you want.

√ If you choose a report on your AS/400, check the library and system
are correct and choose the report you want.

µ To change your AS/400 or library, click on the pull-down list at the
bottom of the screen. If your system is not shown, it must be
configured via Client Access/400 or the L Connect and the
Connection Wizard for TCP/IP.

µ Use the More about button to see information about reports. 

√ Click OK to load this report definition. Jacana displays the report’s
layout in the layout window and lists the fields in the DataCrafter.

√ You can now modify your report definition.

√ Remember to Save your new report definition.

EcY^W�Q�TQdQ�c_ebSU

To create a new report from a data source (a subset or a database file):
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√ Click on the New button or choose New from the File menu.
Jacana displays the New Report dialog box.

√ Choose the Blank report using data from option.

√ Choose the data source you want to use from the drop-down list or
click on the Choose Data button to see the Choose Data dialog box.

√ Choose either the Subset or Database file tab depending on the
data you want to use.
If you are working off-line, only locally saved (on your PC) data
sources are available.

√ Choose the appropriate system and library.
For a database file the library must be the library where the
database file is, not the server product library.

√ Choose the subset or database file you want to use for your new
report definition.

µ Use the More about button to see information about a data source.
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√ Click OK to load this data. Jacana displays a default report layout
in the layout window and lists the fields in the DataCrafter.

√ You can now create your report. Remember to Save your new
report definition.

V =_TYViY^W�Q^�UhYcdY^W�bU`_bd�TUVY^YdY_^

Sometimes you may want to change a report that you have already
defined. This may be due to changing user needs or other changes, for
example, a report did not give the exact result you wanted.

To modify an existing report definition:

√ Click on the Open button or choose Open from the File menu.
Jacana displays the Open dialog box.

µ Jacana lets you have multiple report definitions open at any time.

√ Choose either the Local or AS/400 tab, depending on whether the
report definition you want is on your PC or on the AS/400.

√ If you choose a report on your PC, check the disk drive and
directory are correct and choose the report you want.

√ If you choose a report on your AS/400, check the library and system
are correct and choose the report you want.

√ Jacana retrieves your report definition and displays it on your
screen.
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√ Remember to either Save your report or Save As to create a new
report.

V CQfY^W�i_eb�bU`_bd�TUVY^YdY_^

You must save your report definitions to the AS/400 before you can run
them using your server product. You can save your report definitions
locally (on your PC) and on your AS/400.

µ You might want to save your report definition locally if you want to
work on it later, without signing on to your AS/400. You will have to
save it to your AS/400 when it is finished so your server product can
run it.

CQfY^W�Q�^Ug�bU`_bd�TUVY^YdY_^

To save a new report definition:

√ Click on the Save button or choose Save or Save As from the File
menu. Jacana displays the Save As dialog box.

√ Choose either the Local or AS/400 tab depending on whether you
want to save this report definition on your PC or AS/400.

√ If you want to save the report on your PC, check disk drive and
directory are correct and enter a file name.
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√ If you want to save the report on your AS/400, check the library and
system are correct and enter a report name.

√ Click OK. Jacana saves your report definition.

µ When you save a report definition locally (on your PC) it is held as a
separate file. Report definition files have the default extension .REP.

CQfY^W�Q�]_TYVYUT�bU`_bd�TUVY^YdY_^

To save a modified report definition, using the same name, complete
this procedure. The version you save replaces the original version of the
report definition.

√ Click on the Save button or choose Save from the File menu.
Jacana saves your report definition and updates the saved report to
include your changes.

CQfY^W�Q�]_TYVYUT�bU`_bd�TUVY^YdY_^�Qc�Q�^Ug�bU`_bd
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To save a modified report definition as a new report definition:

√ Choose Save As from the File menu.

√ Choose either the Local or AS/400 tab depending on whether you
want to save this report definition on your PC or AS/400.

√ If you want to save the report on your PC, check disk drive and
directory are correct and enter a file name.

√ If you want to save the report on your AS/400, check the library and
system are correct and enter a report name.

√ Click OK. Jacana saves your report definition.

µ When you save a report definition locally (on your PC) it is held as a
separate file. Report definition files have the default extension .REP
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For a specific report you may not need all the fields that are available.
To save time scrolling through a long picking list you may prefer to
work with a smaller number of fields, in a working list.

µ Click on the Picking List button to see the list of available fields.
Click on the Working List button to see the fields that are being
used.

 A working list is made up of the fields used in any part of the report
definition. These can be fields used in specifications, fields dragged into
the report and fields that you chose from the picking list by using the
checkbox.

 To choose fields to use in a report:

√ Use the mouse or cursor keys to scroll through the list of fields
shown in the DataCrafter.

√ Click on the checkbox for each field you want to use in your report.

√ Click on the Working List button  to show only the chosen fields.

You can filter fields into the picking list from the data source. You can
do this by using the filter picking list function. For further information
on the filter picking list function refer to the Using filters section of this
guide.
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When you run a report, it is the fields you specify in the report
definition that determine what information is shown. An important
part in creating a report definition is adding the correct fields in the
correct place. Jacana makes this easy by allowing you to drag-and-drop
the field from the DataCrafter into the exact place you want it in the
layout window.

You can add fields to your report in one of three ways. You can either
use

♦ your mouse,

♦ your keyboard, or

♦ a menu.

µ Use the right mouse when adding fields. Jacana displays the
shortcut menu to help you.

EcY^W�i_eb�]_ecU

To use the mouse to add a field to your report definition:

√ Click on the field you want in the DataCrafter.

√ Drag-and-drop the field where you want it in the layout window.
Jacana shows an outline of the field as you position it in the layout
window. Drop it where you want it to be.

√ If you used the right mouse button, Jacana displays a shortcut
menu.

√ Choose the field option you want to insert into your report
definition. Any option that is not available is ‘grayed out’.
Headings are added at the top of the report layout, labels are shown
to the left of the field and totals are shown at the bottom of the
report layout.

√ If you used the left mouse button only, Jacana inserts the field into
your report layout.
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√ If you use the left mouse button with one of these keys, Jacana will
include the detail shown.

This key Adds this

Shift Field and heading

Alt Field and totals

Ctrl Field and label

Note: You can use these cumulatively, e.g. dragging a field with the
left mouse button while holding the Shift and Alt keys will insert
the field with its heading and totals.

EcY^W�i_eb�[UiR_QbT

To use the keyboard to add a field to your report definition:

√ Place the cursor exactly where you want the field inserted into the
layout window.

√ Press the & (ampersand) key. Jacana shows a pop-up box with the
name of current field from the DataCrafter.

√ Enter the first character(s) of the field you want. Press space or
Enter to accept the field or press Esc to cancel.

√ If you hold one of these following keys as you press space or Enter,
Jacana will include the detail shown.

This key Adds this

Shift Field and heading

Alt Field and totals

Ctrl Field and label

Note: You can use these cumulatively, e.g. holding the Shift and Alt
keys will insert the field with its heading and totals.
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To use a menu to add a field to your report definition:

√ Place the cursor exactly where you want the field inserted into the
layout window.

√ Highlight the field you want in the DataCrafter (This step is
optional).

√ Choose the Layout menu.

√ Choose the Insert field option. Jacana shows a pop-up box with the
name of current field from the DataCrafter.

√ Enter the first character(s) of the field you want. Press space or
Enter to accept the field or press Esc to cancel.

√ If you hold one of these following keys as you press space or Enter,
Jacana will include the detail shown.

This key Adds this

Shift Field and heading

Alt Field and totals

Ctrl Field and label

Note: You can use these cumulatively, e.g. holding the Shift and Alt
keys will insert the field with its heading and totals.

9^cUbdY^W�Q^T�9^cUbd�?fUbdi`U�]_TU

If you are working in Overtype mode and insert a field in the same
location as or overlapping another field, it will replace that other field.
If you are working in Insert mode, the field will be inserted and both
fields will be in your report layout.

If you are working in Overtype mode and use Backspace or Delete to
remove fields and/or text, Jacana will not move the material to the
right, i.e. the positioning of other fields and text is retained.
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If you are working in insert mode, fields and text may be pushed past
the right boundary of your report. When saving the report, Jacana will
issue a diagnostic message to warn you if this has occurred. To find
fields or text which is beyond the right boundary of your report, either:

♦ Press the delete key repeatedly until the fields or text is shown, or

♦ Use output settings to make your report sheet wider.

BU]_fY^W�VYU\Tc�Vb_]�Q�bU`_bd�TUVY^YdY_^

You may need to remove a field from your report definition. This is
done very easily. To remove a field:

√ Click on the field you want to remove.

√ Press the Delete key or the Backspace key. Jacana removes the
field.

To remove a selection of fields and text from your report::

√ Use you mouse to lassoe the data you want deleted.

√ Press the Ctrl + X. Jacana removes the selection.

V 1TTY^W�dUhd�d_�i_eb�bU`_bd�TUVY^YdY_^

To add text to your report definition:

√ Position the cursor in the layout where you want to add the text.

√ Type the text you want to add to the report layout.

� Check the overtype indicator.
If you are in overtype mode the characters you type will
overtype or replace the existing characters.
In insert mode, Jacana inserts your text while keeping all
the existing information.
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After you have created the basic layout and contents of your report
definition, perhaps using the ReportWizard, you can refine it further.
You can specify quite detailed and/or complex specifications for sorting,
selecting, summarizing, manipulating and displaying the data and the
report. This helps you get exactly the report you want.

Using the Report Specifications dialog box you can set:

♦ how the data is sorted (sort tab)

♦ how the data is summarized (summarize tab)

♦ the run-time parameters (parameters tab)

♦ the run-time selections (select tab)

♦ the calculated workfields (calculate tab)

♦ where page breaks occur for the report (page skip tab), and

♦ Cut, copy and paste report-defined fields.

 

√ You can see this dialog box by either:

» Choosing the Specifications option from the Report menu, or

» Clicking on the Report Specifications button on the standard

toolbar. 

 Use this dialog box to build calculations, parameters, workfields and
select/omit parameters for your report definition.

 The Report Specifications dialog box has six tabs, which allow you to
set different types of report specifications. Each tab, described in the
following sections, has a row of buttons along the bottom of the window
to allow you to quickly set the specifications you want for your report.
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 You can use the data fields in setting many of the report specifications.
Simply drag-and-drop the field you want from the DataCrafter into the
dialog box and apply the specifications you need. Dragging fields here
works in much the same way as in the layout window. If you drag-and-
drop a field with the left mouse button, Jacana inserts the field into the
dialog box. If you drag-and-drop a field with the right mouse button,
Jacana displays a shortcut menu from which you can choose the field
option you want You can also see this menu by clicking on a field in
this dialog box using the right mouse button.

 With each of the tabs in the Report Specifications dialog box you can
use multiple fields. You can combine fields to create complex tests or
specifications to suit your needs.

 The Report Specifications dialog box has buttons down its right hand
side that can help you build the specifications. The buttons have the
following actions.

 toggles the Pinned status of the specification
dialog. If pinned, when the escape key is pressed,
the specifications dialog will remain open, but
focus will be passed to the Layout window. Close a
pinned dialog using the standard Close Window
button in the title bar.

 This is equivalent to the Keep open menu option of
the control-box menu (shown by Alt + spacebar or
right click on dialog title).

 adds the current field from the DataCrafter into
this dialog box. Or you can drag-and-drop a field
from the DataCrafter.

 removes the current field from the dialog box list.

 ‘promotes’ the current field up the dialog box list.
You can use this to change the order in which, for
example, a report is sorted or the calculated fields
are processed.

 ‘demotes’ the current field down the dialog box list.
You can use this to change the order in which, for
example, a report is sorted or the calculated fields
are processed.

 cuts the chosen field from the specification field
list. This field is then available for pasting to the
specification dialog of another report or sheet.
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 copies the chosen field from the specification field
list. This field is then available for pasting to the
specification dialog of another report or sheet.
E.g. Use the copy and paste buttons to copying a
work field from one report to another.

 pastes a cut or copied field.

 displays the properties of the current field.
NOTE: In some tabs (such as Summarize, and
Selection) this button shows the properties for the
based on field. This is because there may be
several report-defined fields arising from the one
entry in the specifications field list.
To see the properties for Summary or Select fields:
1. Click on the appropriate QuickFilter in the

DataCrafter.
2. Choose the field you want to show properties

for.
3. Click on the  button in the DataCrafter.

 For help in this dialog, click help button  in standard toolbar, then
click on the item you want help for.

 The following description of the six Report Specifications tabs describes
how to create the various types of specification you can add to report
definitions using the mouse. You can choose to use these buttons to do
many of the same functions.

 Any fields used or created using this dialog box are available using the
QuickFilters in the DataCrafter.

µ Use your mouse.
You can use the mouse to do nearly everything - drag fields, build
expressions, add specifications, etc.

C_bd�dQR

Use this tab to choose the fields to sort your report by.

You can control the order in which data appears in your report by
specifying sort fields and sort levels. For example, a company sales
report might show for each COMPANY a list of products, and for each
PRODUCT, a list of the INVOICES involved. This report would have
the sort sequence:

COMPANY (major)
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PRODUCT

INVOICE (minor)

COMPANY, PRODUCT and INVOICE are the sort fields. COMPANY
is the major sort field, that is, it has the lowest sort level value.
INVOICE is the minor sort field and has the highest sort level value. A
different report would be produced if the sort sequence was changed to:

PRODUCT

COMPANY

INVOICE

The report would contain the same data but with a different emphasis.
It would show, for each PRODUCT, a list of COMPANIES; and for each
COMPANY, a list of INVOICEs - a product sales report rather than a
company sales report.

You can sort using any field, including sub-totals.

To specify a sort:

√ Click on the Sort tab. Jacana shows this dialog box.

√ Drag-and-drop the field you want to sort by into the dialog box.

√ Click on the button to choose either:

 an ascending sort,

 or descending sort.



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

@QWU :�&& :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

√ Click on the page break button if you want Jacana to insert a page
break when the sort field changes value.

If you do set a page break, this is also shown in the Page Skip tab.

√ Set the spacing between sorted detail lines with the Blank lines to
space box.

This is the number of blank lines inserted between groups in the
sorted detail lines of the output. You can set the spacing from 1 to 9
lines. Inserting space into the output makes it easier for the user to
read, particularly if no “Change of...” line types have been used.

CU\USd�dQR

Use this tab to determine what data appears in the output. You can
specify the fields that will be used to choose the data to include or
exclude (select or omit) in the report.

♦ A select field is used to include data in reports.

♦ An omit field is used to exclude data from reports.

 For example, you could create a select test that included records for
particular warehouses. Or you could create a report that omitted
customers with a zero balance. You can also allow the user to specify
the select/omit value when they run the report.

 You can specify a set of rules or tests for each select/omit field. These
are used to pick the records used in the output report.

 For each record, the value of the select field is tested against the rules.
If the values satisfy the test criteria, the record is accepted for
inclusion in the report.

 Any field can be used to select or omit data providing it has not been
specifically excluded from being used in this way in the server product’s
data dictionary definition, e.g. Report page number.

 Select and Omit selections work in exactly the same way, just click on
the appropriate button.
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 To specify a select/omit test:

√ Click on the Select tab. Jacana shows this dialog box.

√ Drag-and-drop the field you want to select by into the dialog box.

√ Click on either the

 select or

 omit button,
depending on what kind of test you want. That is, do you want to
include or exclude records from the report?

√ Either type the select/omit test expression in the box or click on the

builder button. 
Jacana displays the Select Builder dialog box.
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√ Check that the matching records indicator is correctly set to select
or omit.

√ Enter or build the select test expression. You can either type the
expression into the Select Test box or build it using the buttons.
Clicking on a button will insert that operator or variable at the
current cursor location.

µ Jacana gives hints on how to build your expression in the bottom of
the dialog box.

 Logical operator buttons

 Logical IF command

 Logical AND command to join select/omit tests

 Logical OR command to add an alternate select/omit test

 Operator/mathematical function buttons. Use these to determine
how data will be selected or omitted. For example, you could be
asking the run-time user to specify what value a record must
equal to be included.

 equal to. Allows you to ask the user what the value must be
equal to to be selected/omitted.

 containing. Allows you to ask the user what the value must 
include to be selected/omitted.

 in the range. Allows you to ask the user to specify a range 
that the value must fall in to be selected/omitted.

 in the list. Allows you to ask the user to specify a list of 
acceptable values that may be selected/omitted.

 shows a menu of other conditional operator functions.

 Value buttons

 inserts the current field from the DataCrafter into the 
expression.

 run-time variable. This allows the variable to be asked for 
when the report is run on the AS/400.

 ignore sign or case. Instructs the AS/400 to ignore the sign 
or case of the record, e.g. ‘a’ is treated as ‘A’.



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

:QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

@QWU :�&)

 comma. Use this to separate items in a list or range.

 shows a menu of special values.

√ You can create linked tests for a field using the IF, AND and OR
buttons.

√ Click OK to finish building your select test.

µ You can edit the run-time prompt text. This is the prompt the
AS/400 will show when asking for the run-time select/omit values.
Click on the Run-time interface button or use the Run-time
Interface option from the Report menu. For further details, refer
to the Editing the run-time interface section of this guide.

@QbQ]UdUbc�dQR

Use this tab to add run-time parameters to your report definition.
These are parameters that are accepted into the report and used in the
report’s processing. For example, you could have a parameter that asks
for that day’s exchange rates and then uses those rates to calculate
various figures and totals for the report. Parameters allow additional
flexibility in running a report.

Parameters can affect the type of report that is run. Some examples of
how parameters can affect or influence report processing include:

♦ A run-time parameter that allows the user to perform ‘what-if’’
reports, e.g. what if the commission or the selling prices were
changed by 15%? You could do this by creating a workfield with the
formula
New Selling Price = Existing Selling Price x (1 + Parameter / 100).

♦ A run-time parameter asking the user what level of detail they
want in their report, e.g. by conditioning detail lines with the
formula:
Parameter ‘Show detail?’ = YES.

♦ A run-time parameter asking what the minimum, threshold level is
of a field to include that record in a report.

♦ A run-time parameter prompting the user to indicate if they are
running an end-of-month or end-of year report and thus
determining what calculations are performed and what information
is shown in the output.
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 Run-time parameters can allow you to effectively create different
reports from one report definition rather than having multiple report
definitions. This is done by having the user choose what they want
when they run the report on the AS/400.

 A run time parameter must be associated with a field from the picking
list and it will adopt the attributes of this field.

 To specify a run-time parameter:

√ Click on the Parameters tab. Jacana shows this dialog box.

√ Drag-and-drop the field you want to attach a run-time parameter to
into the dialog box.

√ Click on the extended definition button. 
Jacana displays the Parameter Definition dialog box.

√ Enter the prompt text. This is the text the user will be shown when
asked for a value for this field.

√ Enter the default value. This is the value to be used if the user does
not enter a value.

√ Click OK to finish defining the parameter.
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µ You can add further run-time prompt text. Click on the Run-time
interface button or use the Run-time Interface option from the
Report menu. For further details, refer to the Editing the run-time
interface section of this guide.

Ce]]QbYjU�dQR

Use this tab to add summary fields to your report definition. Summary
fields can include totals, averages, maxima, minima and counts.

To add a summary field:

√ Click on the Summarize tab. Jacana shows this dialog box.

√ Drag-and-drop the field you want summary values for into the
dialog box.

√ Click on the summary buttons you need. You can have various
summary values for each field. The buttons allow you to add:

normal total (numeric fields only)

running total (numeric fields only). A running total is the 
total of the contents of the field for all the records included 
so far.

page total (numeric fields only)

average (numeric fields only)

maximum value

minimum value
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number of records (count), and/or

number of unique values (count).

3Q\Se\QdU�dQR

Use this tab to create workfields or calculated fields to add to the
report definition.

A workfield contains one or more expressions for calculating a value
and a set of conditions that control which expression is used at a
particular time. Workfield expressions can include mathematical
computation, character string manipulation and/or logical comparison.

For example, to create a report that will let the user determine the
products that need to be reordered, you could include all of the
following fields below in the report output and then do the reorder
calculations by hand.

Field name Field description

QOHD Quantity on hand

QORD Quantity committed to fill orders

QDEL Quantity awaiting delivery to us

QROL Level at which to reorder

Alternatively, you could create a workfield that calculated a net
quantity on hand (i.e. QOHD + QDEL - QORD) for each product. This
workfield can then be included in the output instead of the raw data,
saving the user the trouble (and the potential for error) of calculating
the figures.

For every workfield you create, you must specify the field
characteristics. These can include field type, edit codes, etc. You must
then define the expression that will be used to calculate a value for the
field.

A workfield can contain up to 20 alternative expressions by using
conditions. For further details on conditions, refer to the Condition
builder section below.

During calculation, condition sets are tested in sequence.

If the condition set is satisfied, the associated expression is used to
generate a value for the workfield.



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

:QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

@QWU :�'#

If no condition set is met, the workfield will be calculated using the
expression associated with the else.

The calculation stops when a value has been generated.

When you create a workfield, a field name is automatically allocated to
it.

µ Workfields can be used in the same way as any other data field.

 To create a workfield:

√ Click on the Calculate tab. Jacana shows this dialog box.

√ Drag-and-drop the first field you want to use in your calculation
into the dialog box or press the New Calculation button.

µ The Move Up and Move Down buttons change the processing
sequence for the calculations at run-time. That is, the order in
which calculations are shown here is the order they will be done in
when the report is run.

√ Click on the alpha  or numeric  button to specify the type of
calculation you want. This usually depends on what kind of fields
you are calculating from.
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√ Click on the calculation builder. 
Jacana displays the Calculation Builder dialog box (see next page).
Use this box to help you build calculations.
For simple workfields, the standard dialog is shown:

For conditioned workfields, or if the Conditioned button is clicked,
the expanded dialog is shown:

µ The Expression box can only display one expression at a time. To
see a particular expression for a condition, click on the condition in
the upper part of the dialog box.

√ Enter or build the calculation. You can either type the calculation
into the Expression box or build it using the buttons and/or by
dragging in fields. Jacana gives hints on how to build your
expression in the bottom of the dialog box.
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√ Click on the buttons down the side of the dialog box to:

add a condition. Jacana displays the Condition
Builder.

change a condition. Jacana displays the Condition
Builder.

remove a condition and its related expression.

move a condition up or ‘promotes’ the current field
up the dialog box list. This changes the order in
which the lines are processed.

move a condition down or ‘demotes’ the current field
down the dialog box list. This changes the processing
order.

√ Clicking on a button will insert that operator, function or variable
into the expression at the current cursor location. The buttons
insert the following:

 Field/function buttons

 inserts the current field from the DataCrafter into the 
condition.

 shows a menu of available functions.

 Parentheses buttons

 open parentheses

 close parentheses

 Arithmetic operator buttons

 plus

 minus

 multiply

 divide

 percentage
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 Character operator buttons

 join two character strings, including any trailing blank 
characters in the first string.

 join two character strings, after removing any trailing 
blanks from the first string and then inserting a single 
blank character.

 joint two character strings, after removing any trailing 
blanks from the first string.

√ Click OK to finish building the calculation.

3_^TYdY_^�ReY\TUb

Use this dialog to create conditions that can be used in:

♦ calculation specifications,

♦ controlling the printing of data lines,

♦ matrix columns.

 Each condition set (single group of linked conditions) may contain up to
five condition lines. Within each condition line there must be four
pieces of information. These specify:

♦ the logical relationship of the current condition to the previous
condition - the AND/OR.
The first condition line always started with IF. Succeeding lines can
be either AND or OR.

♦ the field to be tested by the current condition. This can include
workfields.

♦ the comparison operator to use for the test

♦ a value to test against the field - the condition value or field. This
can be a simple fixed value, a complex mathematic computation
(which can include parenthetical material) or character
manipulation.
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 For example, this condition set specifies a zip code from 20,000 to
29,999.

 AND/OR  Field  Comparison
operator

 Condition
(field/value)

 IF  ZIP  >=  20000

 AND  ZIP  <=  29999

√ To show the condition builder:

♦ click on the Condition Builder button  in the Line properties
dialog,

♦ click on the Add or Change buttons in the Calculation builder,

♦ click on the Condition Builder button  in the Matrix
Columns dialog

Jacana displays the Condition Builder dialog box in one of the
following ways:

Building conditions for calculations:

Building conditions for line conditioning:
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Building conditions for matrix columns:

√ Enter or build the condition. You can either type the condition into
the Condition box or build it using the buttons and/or by dragging
in fields. Jacana gives hints on how to build your condition in the
bottom of the dialog box.

√ Clicking on a button will insert that operator, function or variable
into the condition at the current cursor location. The buttons insert
the following:

Logical operator buttons

Logical IF command.

Logical AND command to join conditions.

Logical OR command to add an alternate condition.

Conditional operator buttons

equal to

not equal to

greater than

greater or equal to

less than

less than or equal to

containing. Allows you to ask the user what the value must 
include to be selected/omitted.
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in the range. Allows you to ask the user to specify a range 
that the value must fall in to be selected/omitted.

in the list. Allows you to ask the user to specify a list of 
acceptable values that may be selected/omitted.

shows a menu of other conditional operators.

Field/function buttons

inserts the current field from the DataCrafter into the 
condition.

shows a menu of other available functions.

Parentheses buttons

open parentheses

close parentheses

Arithmetic operator buttons

plus

minus

multiply

divide

percentage

Character operator buttons

join two character strings, including any trailing blank 
characters in the first string.

join two character strings, after removing any trailing 
blanks from the first string and then inserting a single 
blank character.

joint two character strings, after removing any trailing 
blanks from the first string.
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Value buttons

ignore sign or case. Instructs the AS/400 to ignore the sign 
or case of the record, e.g. ‘a’ is treated as ‘A’.

comma. Use this to separate items in a list or range.

shows a menu of special values.

√ You can create linked tests for a field using the IF, AND and OR
buttons.

Click OK to finish building the condition.

@QWU�c[Y`�dQR

Use this tab to set page skips in the report. These will cause the report
to go to a new page or spool file when the chosen field changes in value,
e.g. you could set a stock report to start a new page when the
warehouse number changes.

To set a page skip:

√ Click on the Page Skip tab. Jacana shows this dialog box.

√ Select a report sheet you want page breaks for using the Sheet
pull-down list.

√ Drag-and-drop the field(s) you want to force page breaks by into the
dialog box.
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√ You can create complex page skip tests by using the  and 
buttons to link tests, e.g. you can specify to go to a new page when
one or more fields change value.

√ Click on the New File button if you want to create a new spool file
rather than a page skip.

√ Click on the Restart Page Numbering button if you want to re-set
the page numbering when the report goes to a new page or spool
file. Enter the number you want to re-start at in the box.
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A matrix is an array of columns and rows containing information. The
concept is best shown using an example. Let us consider a report that
shows quarterly sales using simple report design, i.e. not using matrix.

State Qtr Sales Profit

CA 1

2

3

4

1.1

1.0

1.1

1.3

0.3

0.3

0.4

0.5

FL 1

2

3

4

1.3

1.1

0.8

1.4

0.4

0.3

0.2

0.5

The same information can be shown using the matrix concept of using
field values for Quarter to make extra columns:

State Qtr 1 Qtr 2 Qtr 3 Qtr 4

Sales Profit Sales Profit Sales Profit Sales Profit

CA 1.1 0.3 1.0 0.3 1.1 0.4 1.3 0.5

FL 1.3 0.4 1.1 0.3 0.8 0.2 1.4 0.5

As can be seen, the matrix concept makes the report shorter but wider.
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Matrix
column
fields

DUb]c�ecUT�d_�TUVY^U�Q�]QdbYh

There are three components that describe a matrix report.

♦ Matrix column field

♦ Matrix column condition, and

♦ Matrix data field.

=QdbYh�S_\e]^�VYU\Tc

These are the fields shown in repeated groups across each line. In the
example there are two matrix column fields:

♦ Sales, and

♦ Profit.

State Qtr 1 Qtr 2 Qtr 3 Qtr 4

Sales Profit Sales Profit Sales Profit Sales Profit

CA 1.1 0.3 1.0 0.3 1.1 0.4 1.3 0.5

FL 1.3 0.4 1.1 0.3 0.8 0.2 1.4 0.5

=QdbYh�S_\e]^�S_^TYdY_^c

The column fields may be repeated in groups across the report line.
Each group needs a condition to define when data from column fields is
shown in that group. In the example there are four matrix column
conditions.

♦ Qtr 1: Sales Month in range 1 to 3

♦ Qtr 2: Sales Month in range 4 to 6

♦ Qtr 3: Sales Month in range 7 to 9

♦ Qtr 4: Sales Month in range 10 to 12.

State Qtr 1 Qtr 2 Qtr 3 Qtr 4

Sales Profit Sales Profit Sales Profit Sales Profit

CA 1.1 0.3 1.0 0.3 1.1 0.4 1.3 0.5

FL 1.3 0.4 1.1 0.3 0.8 0.2 1.4 0.5

Matrix
column

conditions



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

@QWU :�($ :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

=QdbYh�TQdQ�VYU\Tc

These represent a single column of data. There will be a matrix data
field for each combination of matrix column field with each matrix
column condition. In the example there are eight matrix data fields.

♦ Sales for Qtr 1

♦ Sales for Qtr 2

♦ Sales for Qtr 3

♦ Sales for Qtr 4

♦ Profit for Qtr 1

♦ Profit for Qtr 2

♦ Profit for Qtr 3

♦ Profit for Qtr 4.

State Qtr 1 Qtr 2 Qtr 3 Qtr 4

Sales Profit Sales Profit Sales Profit Sales Profit

CA 1.1 0.3 1.0 0.3 1.1 0.4 1.3 0.5

FL 1.3 0.4 1.1 0.3 0.8 0.2 1.4 0.5

=QdbYh�b_gc

Unlike common spreadsheet implementations of matrices, there are no
special matrix definitions relating to rows. The rows are governed by
sort and summary specifications.

9TU^dYViY^W�]QdbYh�VYU\Tc

Use the matrix QuickFilter to show the matrix fields in the
DataCrafter. This shows several types of fields.

♦ XCNDnnnnnn: There will be one of these for each matrix column
condition. These fields indicate if the condition is true or false. They
are not normally used elsewhere in the report.

♦ XFLDnnnnn: These are the matrix data fields. These fields will
either be shown in layout, or used with summary fields for use
within layout.

♦ Others (such as SUMnnnnn): These are summary fields for the
matrix data fields.

Matrix
data
fields
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Note: It is much simpler to use the ReportWizard to design or re-design
your matrix reports. You may modify your matrix columns using the
Matrix columns dialog. However, you should be familiar with the terms
and concepts for matrix reports (refer to the Terms used to define a
matrix section for further information).

One reason for using the Matrix columns dialog is defining more
complex matrix column conditions than the ReportWizard allows.

Using the Matrix Columns dialog box you can set:

♦ conditions for making matrix columns (the Column Conditions tab)

♦ the fields shown within matrix columns (the Column Fields tab).

 

√ You can see this dialog box by choosing the Matrix Columns
option from the Report menu.

Use this dialog box to build fields for using with matrix columns for
your report definition.

The Matrix Column dialog box has two tabs, which allow you to define
matrix data fields. Each tab, described in the following sections, has a
row of buttons along the bottom of the window to allow you to quickly
set the specifications you want for your report.



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

@QWU :�(& :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

You can use the data fields in setting many of the report specifications.
Simply drag-and-drop the field you want from the DataCrafter into the
dialog box and apply the specifications you need. Dragging fields here
works in much the same way as in the layout window. If you drag-and-
drop a field with the left mouse button, Jacana inserts the field into the
dialog box. If you drag-and-drop a field with the right mouse button,
Jacana displays a shortcut menu from which you can choose the field
option you want. You can also see this menu by clicking on a field in
this dialog box using the right mouse button.

The Matrix Columns dialog box has buttons down its right hand side
that can help you build the matrix column fields. The buttons have the
following actions.

 toggles the Pinned status of the dialog. If pinned,
when the escape key is pressed, the dialog will
remain open, but focus will be passed to the
Layout window. Close a pinned dialog using the
standard Close Window button in the title bar.

 adds the current field from the DataCrafter into
this dialog box. Or you can drag-and-drop a field
from the DataCrafter.

 removes the current field or condition from the
dialog box list.

 ‘promotes’ the current field or condition up the
dialog box list.

 ‘demotes’ the current field down the dialog box list.

 cuts the chosen field or condition from the dialog
box list. This is then available for pasting to the
Matix Columns dialog of another report.

 copies the chosen field or condition from the dialog
box list. This is then available for pasting to the
Matix Columns dialog of another report

 pastes a cut or copied field or condition.

displays the properties of the current field.

 For help in this dialog, click help button  in standard toolbar, then
click on the item you want help for.
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The following description of the two Matrix Columns tabs describes
how to create the various types of specification you can add to report
definitions using the mouse. You can choose to use these buttons to do
many of the same functions.

Any fields used or created using this dialog box are available using the
QuickFilters in the DataCrafter.

3_\e]^�S_^TYdY_^c

Use this tab of the Matrix columns dialog box to add, change or delete
column conditions.

Note: When column conditions are added, new matrix fields are defined
in combination with matrix column fields. The matrix data fields are
not added to layout or summarized unless the report is re-designed
using ReportWizard.

To specify a Column condition:

√ Click on the Column Condition tab. Jacana shows this dialog box.

√ Drag-and-drop the field you want to use in the condition into the
dialog box or press the New Condition button.

Restriction: All Matrix Column conditions must be based on the
same field.

√ The condition box shows a simple default condition. You can enter
the condition in this box.
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√ Click on the Condition Builder button to build a condition. 
Jacana displays the Condition Builder dialog box (see Condition
builder above).

3_\e]^�VYU\Tc

Use this tab of the Matrix columns dialog to add or delete column
fields.

Note: When column fields are added, new matrix fields are defined in
combination with column conditions. The matrix data fields are not
added to layout or summarized unless the report is re-designed using
ReportWizard.

To specify a Matrix Column field:

√ Click on the Column Fields tab. Jacana shows this dialog box.

√ Drag-and-drop the field you want available for matrix columns into
the dialog box.

√ Click on the button to choose:

 total across the page. This creates fields for totaling the 
matrix rows

 total down the page. This creates fields for totaling the 
matrix columns
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Jacana gives you a great deal of flexibility in determining how your
report will look when it is run. In addition to having the ReportWizard
and LayoutWizard features that can quickly set the overall look of the
report you can tailor just about anything in the report just the way you
want it. You can specifically set the:

♦ report sheet properties

♦ line properties

♦ attributes for individual fields.

This section covers each of these options.

<Qi_edGYjQbTc

A LayoutWizard helps you speed up the layout of your report. You can
choose how your report will appear.

To use a LayoutWizard:

√ Choose the LayoutWizard option from the Layout menu. Jacana
displays either:

♦ the first LayoutWizard dialog box, or

♦ the Choose Wizard dialog box.

µ The Choose Wizard dialog is shown only if more than one Wizard is
available, and the Always use default LayoutWizard option is
NOT set.

√ Jacana leads you through a series of dialog boxes that ask you
questions about how you want your report to appear. These
questions include asking you about the:

» output medium

» level of detail

» layout style

» fields to include

» report title.

√ Click on the Finish button. Jacana re-designs the report layout
based on the your answers.
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Reports can have up to twenty sections, which may even have different
output methods. For example, a report may have a detail section and a
summary section, or a report may produce a disk output and a printer
output. The Report Properties option covers the settings for the entire
report. Sheet Properties set how each of the sections or outputs
appears.

The report sheet determines the overall look of your report section or
output. It provides control over the report output, including specifying
control and banner pages, attributes and changes to the output
settings.

All sheets of a report share common report specifications other than
page skipping. This includes sorting, selection, totaling, matrix,
parameters and workfields. See Refining your report - contents

To display or change the sheet properties:

√ Click on the Sheet Properties button or choose the Sheet
Properties option from the Layout menu. Jacana displays the
Sheet Properties dialog box.

 

√ Use the General tab to name the sheet. You can also choose to set
this sheet to be the null report sheet. The null report sheet is used
for any report-run that selects no records. That is, if when the
report is run the values the user enters do not select any records
the null report sheet will be produced. You may also set the page
number starting value, and the page number increment for
subsequent pages.
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√ Use the Banner tab to set how any banner page for this sheet is to
appear. The banner page is the first page printed for the sheet. You
can add or remove text for this page. You can also suppress the
banner page by turning off the Print Banner Page checkbox.

√ Use the Control Page tab to set how the control page(s)  for the
sheet are to appear. The control pages show the selection criteria
used, workfield definitions, run-time duration and the number of
records selected for a report run. You can choose to make them
separate and/or abbreviated. Abbreviated may be appropriate if
there are many select/omit tests and/or workfields. You can
suppress the control page by turning off the Print Control Page
checkbox. You can also override print options.
Note: The host product may have limited overrides. The allowable
override keywords are all shown with default values. Any other
keywords will prevent saving the report to the host product.
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√ Use the Output tab to set the output medium to use for the sheet.
Click the Setup button to make more specific output settings. For
further details on output settings refer to the Changing your output
settings  section of this guide.
You can also allow the user to choose which medium they want by
choosing the Allow change of output medium at run time checkbox
and set the printer overrides for the control page.

√ Click OK to finish setting the report sheet properties.

1TTY^W�cXUUdc

You can add up to twenty report sheets to a report.

To add a sheet to your report definition:

√ Choose the Sheet option from the Report menu. Jacana displays
the Sheet dialog box.

√ Click on the  button.

√ Choose the New menu option.
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√ Set the sheet properties (for further information on sheet
properties, refer to the Setting the sheet properties section of this
guide).

√ Click OK to add the new sheet.

CUddY^W�dXU�\Y^U�`b_`UbdYUc

Using the ReportWizard and/or LayoutWizard functions can set much
of the report’s appearance. But you can enhance your report to exactly
meet your needs by modifying the appearance of individual lines.

To set the line properties for the current line:

√ Click on the line in the layout window you want to set properties
for.

√ Click on the Line Properties button or choose the Line... option
from the Layout menu. Jacana displays the Line Properties dialog
box.

µ If you click on the Line Properties button or choose the Line...
option and the current line is a ‘space’ line between two print lines,
Jacana asks if you want to convert this space line into a print line.
Click on the Convert button to convert this line or click on the
Cancel button and re-select the line you want to set properties for.



:QSQ^Q
EcY^W :QSQ^Q � 2QcYS dQc[c

@QWU :�)$ :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

√ Use the General tab to:

♦ change the type of report line being used (for further
information on report line types, refer to the Report line types
section below)

♦ set the line number this line is to appear/print on the page

♦ set the number of blank lines before and/or after this line

♦ set the line to appear bold and/or underlined.

µ You can use the layout toolbar buttons to set some of these line
attributes. For further information, refer to the Toolbars, buttons
and menus section of this guide

√ Click on the Advanced button to override print controls.
Jacana displays the Advanced Print Controls dialog box. To
override print controls, click on the checkbox and choose the field
you want to use to override the print controls for this line.
Click OK to accept your changes.

 

µ A print control field is six digits long. The format of the field is:

 Position  Line control  Value

 1-2  Skip to line before printing  Absolute line number

 3-4  Skip to line after printing  Absolute line number

 5  Space before printing  0-3

 6  Space after printing  0-3

 
Blanks are not allowed. Use 0 (zero) if the line control is not used
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 This feature is useful if line spacing should vary, e.g. to emphasize
where the quantity on hand is less than the reorder level, you could
include extra spacing by:

♦ defining a calculated field like this:

 Condition  Expression

 QOHD < QROL  ‘000022’

 else  ‘000011’

♦ using the calculated field in the override print controls.

√ Use the Conditioning tab to:

♦ print a line always or only if a specified condition is met. If you
specify a condition, that condition must be met before a line is
printed. For example, you might want a line to print only if a
particular field or total is greater than a certain value.

♦ print data on the next available line on the page or force a page
break if it is close to the bottom of the page. You can set how
close to the bottom of the page this line may appear before
forcing a page break.

√ To specify a condition, you may

♦ type a condition in the condition box,

♦ click on the list pull-down to select from conditions used
elsewhere in the report,

♦ click on the Condition Builder button  to build a condition.

For further details on conditions, refer to Condition builder in
the Refining your report - contents section of this guide.
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√ Click OK to confirm your line settings.

BU`_bd�\Y^U�di`Uc

The report layout is made up of a series of report lines. A report line
can contain data from the database, identification labels, text and/or
space.

The type of report line controls when the line appears in the output. A
report can contain the following types of report lines:

♦ Page header lines appear at the top of every page or screen of
output.

♦ Column heading lines also appear at the top of every page or screen
of output, after the header lines. They describe columns of data.

♦ Footer lines appear to bottom of every page or screen of output.

♦ Detail lines appear between the column header and the footer lines.
They contain detailed information from the database. A detail line
is produced for each record included in the output. This is usually
the bulk of the report - it is the records you have extracted from the
database.

♦ Sort lines appear between the column header and the footer when
there is a change in a particular sort field. They often contain
summary information such as totals. You can specify both leading
and trailing sort lines. Leading sort lines are included in the output
before the data they summarize, i.e. detail lines. Trailing sort lines
follow the data they summarize. Sort lines can include report level
lines and change of lines A report level line is a level of sorting e.g.
grand totals. Change of lines are shown as change of <sort field
name>, e.g. Change of Warehouse Identifier.

♦ Report leader lines occur once at the top of each spool file, after the
banner page. They can contain information such as printer control
commands.

♦ Trailer lines appear once at the end of each spool file. Similarly to
leader lines they can contain information such as end of job
information, printer control commands, e.g. to reset the printer.
They appear as the last print line in the spool file.

√ To change the current line type either:

» choose a new line type from the drop-down list on the layout
toolbar

» click on the Line Properties button, or

» choose the Line... option from the Layout menu.
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µ To see line types for each line in page layout, use Show Line
Types from the View menu.
Move the cursor over the line between the line types margin and
your report layout to resize the line types margin.
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Sometimes you want to change the appearance of a field in your report.
For any field in the report output, Jacana lets you:

♦ change font attributes for bold and underline,

♦ change its print length,

♦ make it print on change of value or always,

♦ apply an edit or transformation.

 To change the appearance of a field:

√ Find the field in the layout window.

√ Click on the field.

√ If you want to make the field bold, click on the Bold button or
choose the Bold option from the Layout menu.

√ If you want to underline the field, click on the Underline button or
choose the Underline option from the Layout menu.

µ For other changes, use the shortcut menu.

√ Use the right mouse button to click on the field in the layout
window. Jacana displays a shortcut menu.

√ Choose the Format Field option. Jacana displays the Format
dialog box, which has two tabs:
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The General tab …

and the Editing tab …

Use these dialog boxes to set or change bolding or underlining, print
length, print on change and edits for this field.
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Jacana shows the layout of your report definition in the layout window.
This is very similar to how your report definition layout will appear if
you print it. However, you can see a more accurate preview of how the
report definition layout will be printed.

To print preview your report definition layout:

√ Click on the Print preview button or choose the Print Preview
option from the File menu. Jacana displays the Print Preview
window showing your report definition layout.

√ Use the buttons along the top of the window to:

♦ print your report definition layout

♦ see the next page of your report definition layout

♦ see the previous page of your report definition layout

♦ see either one page or two pages at a time

♦ zoom in

♦ zoom out

♦ close the Print Preview window.
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To print your report definition layout:

√ Click on the Print button or choose the Print option from the File
menu. Jacana displays the Print dialog box.
(Note: the dialog shown will depend on the printer you are using).

√ Set the print options you want.

√ Click OK to print your report definition layout.

µ You may need to check or change your print setup. Use the Print
Setup option from the File menu to check the setup.
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This section describes how to use Jacana to perform advanced tasks.
These are tasks you may only do occasionally and include how to:

♦ use filters to choose fields

♦ check the data source for a report

♦ change the field properties

♦ change the report properties

♦ change the report output settings

♦ change your data source or server

♦ create report templates

♦ edit the run-time interface prompts.

V EcY^W�VY\dUbc

Jacana allows you to filter at various levels. You can filter the fields
from the data source into the picking list. You can also use
QuickFilters to choose what report definition fields are shown in the
DataCrafter.

To make the picking list easier to handle you can filter fields into the
picking list first. This means you don't have to scroll through a vast list
of fields when you know you only need certain fields.

You can use either:

♦ fully specified filters, or

♦ QuickFilters.

 The picking list filter lets you control the fields shown in the picking
list from the data source. The QuickFilters let you choose which report
definition fields are shown in the DataCrafter.

µ Use the buttons on the data toolbar to filter your fields.
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QuickFilters let you filter fields with just one mouse click. Each
QuickFilter will show just that type of report definition field in the
DataCrafter.

To quick filter the report definition fields:

√ Click on the QuickFilter button you want or choose the
QuickFilter option from the Data menu. The QuickFilters
available are:

 summary fields

 calculated fields

 selection value fields

 matrix fields

 parameter fields

 standard fields.

√ Jacana lists the filtered fields in the DataCrafter.

µ Use the  button to limit the list of summary fields by type and/or
sort level.

6Y\dUbY^W�dXU�`YS[Y^W�\Ycd

Sometimes you want more flexibility in filtering the fields from the
data source. Jacana lets you do this too. Use this option to control
which fields are included in the picking list from the data source.
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To filter your data fields into the picking list:

√ Click on the Filter Picking List button  or choose the Filter
Picking List option from the Data menu. Jacana displays the
Filter Picking List dialog box.

µ You can set the filter criteria from one or more of the tabs in this
dialog box.

√ Use the Fields tab to search for fields:

♦ containing the text you enter in the containing box in either the
long description, short name or column heading

µ Use the Pick Fields Containing edit box in the DataCrafter
as a shortcut to this feature.

♦ with a particular data type

♦ excluding fields currently in use, in the working list or report
fields.

» In use fields are those fields used in the report, either in
the layout or in report specifications.

» In working list fields are those fields listed in the working
list.

» Report fields are those fields that do not exist in the data
source, i.e. fields created in the report definition, e.g.,
workfields, parameters, conditions, select/omit and
summary fields.



:QSQ^Q
EcY^W :QSQ^Q � 1TfQ^SUT dQc[c

@QWU :�! $ :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

 Click on Default to choose all fields except for the report fields.

µ To list all fields, leave the containing box blank, check that both
data type boxes are checked and that none of the exclusion fields
are checked.

µ All four tabs are used for filtering. If you have trouble finding a
field, check all four tabs.

√ Use the Views tab to choose particular data user views to include
or exclude. Views are selections of the server product’s data
dictionary tailored to suit specific users or purposes.
Click on Default to choose just the selected or current view(s).

√ Use the Map tab to choose particular data files to include or
exclude. A map is a graphic representation of the relationships
between the data files.
Click on Default to choose the any file option.
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√ Use the Groups tab to choose particular data groups to include or
exclude. A group contains the fields from files that are linked by 1:1
relationships.
Click on Default to choose all groups except the control group.

√ Click OK to filter the data fields. Jacana reduces the picking list to
include only those fields matching your criteria.
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Jacana lets you check which data source you are using. You can see
where data has come from and check the properties of an individual
field. For further details on checking field properties refer to the
Checking the field properties section of this guide.

To see what data source your report is using:

√ Click on the Data Source button  or choose the Source... option
from the Data menu. Jacana displays the Data Source dialog box.

√ Use the Map tab to see the retrieval map for the data. This shows
the relationships between the data files that make up the data
source. For each file you can see the file name, library, format and
type.
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√ Use the Subset tab to see the data subset that is currently being
used. This tab shows the name and description of the subset, the
number of groups and fields, where it was loaded from and whether
it has been version checked (that is, the local version has been
checked against the current AS/400 version). The tab also shows
which system and data library is to be used.
NOTE: If the data source is a database file, the tab is named
Database file and differs slightly.

√ Click OK to continue.
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Jacana lets you see and/or change the properties of any field in your
report definition.

To see the properties for a particular field:

√ Click on the field, either in the DataCrafter or in the layout
window.

√ Click on the Field Properties button  or choose the Field
properties option from the Layout menu. Jacana displays the
Properties dialog box.
NOTE: When displaying properties of report fields, you can use the
General, Text and Editing tabs to change some of the properties
of report fields. You cannot change properties of fields from the data
source. When showing properties of report fields, an additional tab
is shown named Specification, which describes how the report
field is defined.

√ Use the General tab to see and/or change basic information for this
field. The information shown includes the field type, size and
whether the field can be used for printing, sorting, selecting and
summaries.
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√ Use the Text tab to see and/or change the identification details for
this field. The information shown includes a description of the field
and the text used as a label or column heading for this field.

√ Use the Editing tab to see and/or change edit codes for this field.
These edit codes and macros can be used to alter how the field is
printed in the report output.
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√ Use the Subset tab to see the subset details for this field. The
information shown includes the user name, internal name, subset
group, subset and subset name that this field comes from.

√ Use the Map tab to see data retrieval map details for this field.
This shows the relationship between the data files in the data
source. The information shown here includes the original name, file,
library and format of the field.

√ Click OK to continue.
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To see the properties for a report:

√ Click on the Report Properties button  or choose the
Properties... option from the Report menu. Jacana displays the
Report Properties dialog box.

√ Use the Report tab to see or change:

♦ user name (this is the user’s name for the report when saved on
an AS/400)

♦ report description

♦ security (access rights - are other AS/400 users allowed to run,
change or delete this report?). Note: This option is only
available for new reports. If the report has already been saved
to the server, use the security features of the host product to
change the authorities.
The security options are:

» Default - other users access to the report is determined by
the default access nominated by the host product

» Other users can run this report

» Other users can run, change or delete this report

» Other users have no access to this report.
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♦ processing modes (these control the AS/400 environment in
which a report will run. For further details, refer to your server
product documentation.)

♦ local file name (the name of the file used to save this report
definition locally on your PC).

√ Use the Data tab to see name and description of the data. Click on
the Properties button to see the data source details. For further
information on this refer to the Checking your data source section of
this guide.

√ Use the Statistics tab to see the creation and run statistics for this
report. These include the dates on which this report was created,
last changed and last used in addition to average duration for
running the report.
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√ Use the AS/400 tab to see AS/400 details for this report, including
the internal name, system and data library details. This is useful if
you are saving report definitions locally (on your PC) and are using
reports from different sources.

√ Click OK to continue.



:QSQ^Q
EcY^W :QSQ^Q � 1TfQ^SUT dQc[c

@QWU :�!!$ :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

V 3XQ^WY^W�i_eb�_ed`ed�cUddY^Wc

A report can be created to produce output for a printer, a screen or a
disk file. You must specify the output medium you want your report to
use. A report normally has one specific output medium that you want it
to use. However, it can be output to another medium.

Each output medium has different settings that you can control, for
example you should specify how many lines you want per page on a
printer report.

To see or change the output settings for your report:

√ Click on the Sheet Properties button or choose Sheet properties
from the Layout menu. Jacana displays the Sheet properties dialog
box.

√ Click on the Output tab. Jacana shows the current output settings.

√ Choose the output medium you want from the Preferred output
medium drop-down list.

√ You can see or change the settings for this output medium by
clicking on the Setup button.

√ You can allow the user to change the output medium when they run
the report. To do this, click on the checkbox marked Allow change of
output medium at run time.

√ Click OK to accept the changes.

µ You can change the settings for each output medium. When the
user selects an output medium at run time, the settings you entered
will be the default output settings for that medium.

 To see or modify the settings for your current output medium, follow
this procedure.

√ Click on the Output Setup button or choose Output setup from the
Layout menu. Jacana displays the Output setup dialog box. There
is a different tab for each output medium.

The PC download tab gives options for formatting the report output
into one of several PC-based application formats, e.g. for a spreadsheet
or database.
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Use this tab to specify how the report will be printed.

√ Use the first section of the tab to set:

♦ the length and width of the printed area

♦ the last line to print DETAIL or SORT lines on

♦ the last line to print on.

√ Use the second section of the tab to specify how many records to
print to a line, including the spacing between records, e.g. for
printing labels

√ You can also direct printer output to printer files. Use the last
section of the tab to name the:

♦ printer file

♦ library, and

♦ any overrides you require.
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 Note: The host product may have limited overrides. The allowable
override keywords are all shown with default values. Any other
keywords will prevent saving the report to the host product.
Click on the Default button to use the default printer file
name.

µ For further details about printer file settings, refer to your server
product documentation.

√ Click OK to accept your output settings.

G_b[cdQdY_^

Use this tab to specify how the report output should appear on a
workstation screen.

√ Use the first section of the tab to set:

♦ the length and width of the screen

♦ the last line to display DETAIL or SORT lines on

♦ the last line to display information on.
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√ Use the second section of the tab to specify how many records to
show on a line, including the spacing between records.

√ Click OK to accept your output settings.

4Yc[

Use this tab to specify how the report output should be saved as disk
output. Definitions for disk file output should be detail reports or
simple summary reports. Reports that are designed to produce output
for other output media should not be used to produce disk file output.

√ Use the first section of this tab to set:

♦ names for the file, library, members and records

♦ maximum length of records.

Click on the checkbox if these names are to be set and
maintained by your server product. The server product deletes
and re-creates a maintained file each time the report is
compiled.

√ Use the second section of this tab to choose whether you want to:

♦ add (append) the data to any existing data or

♦ replace (overwrite) any existing data.
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√ Use the last section of the tab to choose the format to save the data
in. You can choose AS/400 native format with or without field
descriptions.
‘With field descriptions’ inserts the field names and delimits the
entries in the output file.
‘Without field descriptions’ creates a file with no field names and
each record is essentially a single un-delimited entry.

√ Click OK to accept your output settings.

@3�4_g^\_QT

Use this tab to specify how the report output should be formatted to be
suitable for PC applications such as spreadsheets, word processors or
other data processing applications.

√ Choose the PC output format that is suitable for use by your PC
application. Often there will be a PC format that contains the name
of your PC application. If not, the format Comma Separated
Variables is suitable for importing to many applications. Refer to
your host product for details of setting up macros specific for a PC
application.

√ Click on the transfer to folder option to cause output from this
report to be transferred to AS/400 folders ready for access by your
PC.
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√ Use the folders section of this tab to name the AS/400 folder where
the output is to be stored. A PC may then access the AS/400 folder
via shared folders or mapped network drives.

√ Click OK to accept your output settings.

V 5TYdY^W�dXU�be^�dY]U�Y^dUbVQSU

When the report definition is run on your AS/400 the user may be
asked to enter various select/omit values and/or run-time parameters.

This option allows you to add text to the prompts for the select/omit
and parameter specifications you included in your report definition. For
further details on specifications refer to the Refining your report -
contents section of this guide.

To edit the run-time interface text:

√ Click on the Run-time interface button or choose the Run-time
interface option from the Report menu. Jacana displays the Run-
time interface dialog box. This lists all the current run-time
prompts the user will be shown.

 

√ The items are shown in the order they will be shown to the user at
run-time. You can move individual lines of text or entire tests, e.g.
select criteria. Click on the Move up button to move an item up the
list or click on the Move down button to move an item down the
order.
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√ Click on the Insert text button to add text that may help a user
enter a run-time value, i.e. you can provide an explanation as to
what value is required. Jacana displays the Run-time text pop-up.

Enter your prompt text. Click OK to return to the Run-time
interface dialog box.

√ Click on the Change text button to edit your prompt text. Jacana
displays the Run-time text pop-up. Enter your prompt text. Click
OK to return to the Run-time interface dialog box.

√ Click on the Remove text button to remove the current
(highlighted) line of text. You can only remove text lines, not the
request for a run-time value.

√ Click OK to accept the run-time interface settings.

µ To change or remove a test, e.g. a select/omit test or a run-time
parameter, use the Specifications dialog box. For further details,
refer to the Refining your report - contents section of this guide.
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Jacana uses report templates when you create a new report definition.
The default report template (JACANA.RET) specifies default heading and
footer lines containing:

♦ report name

♦ report title

♦ page number

♦ date and time of report production.

Additionally, the report template contains default values for output
settings and other report properties.

3bUQdY^W�Q�bU`_bd�dU]`\QdU

You can create your own report template. To create a template:

√ Design a report layout as you would for a normal report definition.

µ Only use fields from the Control Group. If you use any other fields,
they will not be saved in the report template.

√ Choose Save As from the File menu.

√ Choose the Local tab to save this template on your PC.

√ Check disk drive and directory are correct and enter a file name.

√ Choose the Jacana Report Templates (*.ret) option from the Save
File As Type drop-down list.

√ Click OK. Jacana saves your report template.

µ Jacana currently uses just one template. This template is specified
in the system settings. If no template is specified, Jacana uses the
JACANA.RET template in the Jacana directory. For further
information on changing system settings, refer to the online help for
the Jacana options.
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When you start Jacana it automatically connects to the system and
data library you last used. Sometimes you may want to change which
server or system is used.

To change your server:

√ Choose Server from the File menu. Jacana displays the Server
dialog box listing the servers your router has been configured for.

√ Choose the AS/400 server you want to use.

√ Click OK to use this server. Jacana accesses that server.

µ You can also change your data source, including the server, when
you start a new report definition. For further details refer to the
Creating a new report definition section of this guide.
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This section provides information on error messages you may
encounter when using Jacana and information about Jacana’s version
checking.

V =UccQWUc�Vb_]�dXU�cUbfUb�`b_TeSd

When you get a message from the server product, it may be an
information message that is shown in the status bar or it may be
shown in a dialog box. Messages shown in a dialog box tend to be more
important and appear like this:

√ Click on the Cause button to see an explanation of the message and
possible solutions.
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The following types of problems may cause other error messages.

=YccY^W�`b_TeSdc

Check that you have installed all the necessary software. For further
details, refer to the Preparing for installation section of this guide.

9^S_]`QdYR\U�\UfU\c

Check that you have installed the appropriate versions of all the
necessary software. For further details, refer to the Preparing for
installation section of this guide.

9^ceVVYSYU^d�]U]_bi

Check that your PC has the necessary configuration or reduce the
number of active applications.

For details on required hardware configuration, refer to the Preparing
for installation section of this guide.

B_edUb�^_d�\_QTUT

The router is the communications software that allows your PC to
communicate with the AS/400. Before staring Jacana, check that a
suitable router has been started. Suitable routers include:

♦ Client Access

♦ NS/Router.

µ For further information on Jacana and solving errors, refer to the
on-line help.
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If the AS/400 is not responding, check the following:

♦ is the PC currently connected to the AS/400?

♦ is the AS/400 active?

♦ have you started the router software to connect to the AS/400?

♦ is the Partner program name correctly set? To change the Partner
program, refer to the Jacana Administrator.

♦ is the connection setting correct? To change the connection, choose
the Server option from the File menu.

♦ are there any messages on the AS/400 operator’s message queue?

E^\YSU^cUT�`b_TeSd

Refer to the Licensing Jacana section of this guide.
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The reporting components of your server report writer product reside
on your AS/400. Jacana allows you to design new report definitions on
your Windows-based PC from the data source you specify.

To do this, Jacana needs the data source definition from your server to
be loaded onto your PC. Once this is done you can design new report
definitions or modify existing ones using Jacana. With the data source
definition on your PC, you can design report definitions for that data
source without connecting to your server. When your report definition
is complete, you can then load it back to your server.

This offers great flexibility, but has potential for problems as someone
working in the server environment can alter the data source definition.
When the report definition is ready to be loaded back to the server, the
data source may have changed, potentially making your report
definition invalid.

To prevent invalid report definitions being resident on the server,
Jacana performs version checking when the report definition is saved
back to the server. Jacana warns you if there has been a modification of
the data source that may cause the report definition to be invalid or
unexecutable.
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A single server product can support many Jacana users. It is possible
for more than one user to download and modify the same report
definition at the same time. Users working in the server environment
may also be modifying the report definition.

Jacana detects version mismatches when report definitions are saved
to the server, issuing appropriate warning or other messages advising
of the version mismatch and the actions available.

A version check mismatch can occur when saving to the server:

♦ a new report definition based on a different version of the data
source to that now available on the serve

♦ a modified report definition, where the current server version of
that definition is later than the version you down-loaded for
modification

♦ any report based on a data source that has since been deleted.



:QSQ^Q
Db_eR\U�cX__dY^W

@QWU :�!"( :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

?dXUb�S_^cYTUbQdY_^c

♦ It is possible for an authorized user operating in the server
environment to change the authorities, i.e. access rights, to the
server version of the report definition while it is downloaded into
Jacana. For example, they could remove rights to alter the report.
While this is not strictly a ‘version mismatch’, it will prevent the
over-writing of the server version of the report definition, i.e. the
version in Jacana cannot be loaded to the server. In this case, save
the modified version of the report definition as a new report
definition (Save As) or abandon the changes.

♦ Jacana will only load a report definition back to the data library
from which the data source was originally downloaded.
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These exercises introduce you to the major concepts and functions of
Jacana. In these exercises you will become acquainted with the Jacana
window and the various tools by creating a number of report
definitions.

� These exercises build upon each other. It is important that
you do them in the sequence shown.

 Most of the exercises use the report definition you created in the
previous exercise. So save your report definitions when you are asked
to. Use a name you will remember. For example, you could use the
name convention: JACxxxnn.REP, where xxx are your initials and nn is
the number of the exercise you are doing, e.g. JACJJP02.REP.

� Do not use data library EXERCISES unless you have no
connection to an AS/400. You will not be able to run reports
created over data sources from EXERCISES.

V 5hUbSYcU�?^U

Objective: Produce a simple detailed report from an inventory
database showing available and committed stock for parts held
at each warehouse. On completion of this exercise, the report
should look similar to this:

JACiii01XX        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX       Page 99999
                                                          HH:MM:SS DD/MM/YY
                                         Product
Warehouse   Product                       Number  Quantity Quantity
Identity  Description                    Identity  On hand On order
--------- -----------                    -------- -------- --------
  XXXXX   XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 9999999-
  XXXXX   XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 9999999-
  XXXXX   XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 9999999-
  XXXXX   XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 9999999-
  XXXXX   XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 9999999-
  XXXXX   XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 9999999-

JACiii01XX        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX       Page 99999
Note: Guide only. Some characters not positioned exactly.

New concepts:

• The ReportWizard
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• Data sources and fields

• Sorting data

• Basic layout features

• Saving reports

DXU�bU`_bd�gYjQbT

Here you will start Jacana and start the ReportWizard to design a new
report.

√ Start Jacana. Jacana displays the Tip of the Day dialog box.

µ If you have already been using Jacana, this dialog will not be
available. Instead, click on the New button to start a new report
and bypass the next paragraph.

√ Click the Close button. Jacana displays the Jacana start up dialog
box.

 

√ Choose the ReportWizard option. Click OK. Jacana displays either:

♦ the first ReportWizard dialog box, or

♦ the Choose Wizard dialog box.

µ The Choose Wizard dialog is shown only if more than one Wizard is
available, and the Always use default ReportWizard option is
NOT set.
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√ If the Choose Wizard Dialog is shown, choose the standard
ReportWizard and click on the OK button.

√ Click on the Next button. Jacana displays the data source dialog
box.

3X__cY^W�Q�TQdQ�c_ebSU

Here you will specify where the information will be obtained to create
the report. The term ‘data source’ refers to the server (AS/400)
database file or subset you are using. The data source is defined on the
server, but a copy may be saved locally (on your PC).

√ Select the DEMOINVENT data source from the drop down list.

 

µ If this data source is not shown on the drop down list, click on the
Choose Data button. Jacana displays the Choose Data dialog box.
Choose the Subset tab. Choose the DEMOINVENT subset. Click
OK.

√ Click on the Next button. Jacana displays the fields dialog box.

√ Click on the Warehouse identifier field and then click on the >
button. This field is now the first field to include in the report.

µ Fields are listed in alphabetical order.
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√ Now add the other fields:

» Product description

» Product number

» Quantity currently on hand

» Quantity committed to fill orders

 

√ Click on the Next button. Jacana displays the next dialog box. You
have now finished choosing the fields to include in your report.

C_bdY^W

Here you control the order in which lines of data appear down the page
in your report (You will design the report layout i.e. the order of field
placement across the page, in a later step)

√ Click on the Next button. Jacana displays the sorting dialog box,
where you can choose the sequence of records for your report. In
this example you will create a list of products sorted by warehouse
and product number.

√ Click on the Warehouse identifier field and then click on the >
button. This field is now the major sort field.
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√ Make the Product number the next sort field.

√ Click on the Next button. Jacana displays the select/omit dialog
box. You will use select/omit in the next exercise.

√ Click on the Next button. Jacana displays the totals dialog box. You
will use totals in the next exercise.

√ Click on the Next button. Jacana displays the dialog box for
choosing to use matrix columns.

√ Choose the option for No matrix columns. You will use matrix
columns in a later exercise.

√ Click on the Next button. Jacana displays the next dialog box.

2QcYS�\Qi_ed�VUQdebUc

√ Click on the Next button. Jacana displays the output dialog box.
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√ Choose the Print option. This means when the user runs the report
the output will be designed for printing. Click on the Next button.
Jacana displays the details dialog box.

 

√ Choose the Yes, show details option, this is not a summary report.
Click on the Next button. Jacana displays the style dialog box.
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√ Choose the Columnar option, which is the most common type of
report. Click on the Next button. Jacana displays the field order
dialog box. This is where you specify which fields are printed in the
report.

√ Choose the order you want the fields shown in. Click on each field
and then on the > button. Choose the fields in this order:

» Warehouse identifier

» Product description

» Product number

» Quantity currently on-hand

» Quantity committed to fill orders.
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√ Click on the Next button. Jacana displays the title dialog box.

√ Enter a title and name for your report. Enter the name JACxxx01,
where xxx are your initials and the title Jacana exercises.

√ Click on the Finish button. The ReportWizard will now create your
report definition based on the answers you gave. Jacana displays
your report definition.
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Here you will save the report definition. The report must be saved to an
AS/400 before it can be run. However, in these exercises you will not
run the reports. You must save report definitions locally if you want to
continue with later exercises.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx01.REP, where xxx are your
initials.

 

µ Save your exercise files locally (on your PC). Choose the Local tab
from the Save dialog box.

√ Click OK to save your report definition.

√ Choose the Close option from the File menu.

This completes exercise one. You have now created a report definition
using the ReportWizard function. You have chosen the data source, the
fields, how the data is sorted and how the report is to appear.
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Objective: Produce a simple detailed report from an inventory
database showing value of available stock for parts held at each
warehouse. The report should also show totals by warehouse.
On completion of this exercise, the report should look similar to
this:

JACiii02XX        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX       Page 99999
                                                          HH:MM:SS DD/MM/YY
Warehouse ID . . . :  XXXXX

Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                               Product               Product
  Product                       Number    Quantity  Purchase
Description                    Identity    On hand   Price
-----------                    --------   --------  --------
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
                                        999999999-
                                        999999999-

JACiii02XX        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX       Page 99999
Note: Guide only. Some characters not positioned exactly.

New concepts:

• Selecting the data you want

• summarizing data (totals)

• Printing data in the headings.

7UddY^W�cdQbdUT

√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the ReportWizard option. Click OK.

√ If Jacana shows the Choose Wizard dialog box, choose the standard
ReportWizard and click OK

√ Jacana displays the first ReportWizard dialog box.

√ Click on the Next button. Jacana displays the data selection dialog
box.



:QSQ^Q
8Q^Tc�_^ UhUbSYcUc

:QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

@QWU :�!#)

√ Select the DEMOINVENT data source from the drop down list.
Click on the Next button. Jacana displays the fields dialog box.

√ Choose the fields to include in the report definition. Include these
fields:

» Warehouse identifier

» Full warehouse description

» Product description

» Product number

» Quantity currently on hand

» Purchase price for this product.

µ You can double-click on a field to include it in the report definition.

 

√ Click on the Next button. Jacana displays the next dialog box. You
have now finished choosing the fields to include in your report.

√ Click on the Next button. Jacana displays the sorting dialog box.

√ Sort the report by Full warehouse description and the Product
description fields.

√ Click on the Next button. Jacana displays the select/omit dialog
box.
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√ Double-click on the Warehouse identifier field. You have now
specified that when a user asks for this report to run, they will be
prompted to choose which warehouse(s) to include in their report.

 

√ Click on the Next button. Jacana displays the totals dialog box.

D_dQ\c

√ Double-click on the Quantity currently on hand field. You have now
specified that the report will include totals for the quantity on
hand.
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√ Click on the Next button.

√ Choose the option for No matrix columns. You will use matrix
columns in a later exercise. Jacana displays the next dialog box.

√ Click on the Next button. Jacana displays the next dialog box.

√ Click on the Next button. Jacana displays the output dialog box.

√ Choose the Print option. Click on the Next button. Jacana displays
the details dialog box.

√ Choose the Yes, show details option. Click on the Next button.
Jacana displays the style dialog box.

√ Choose the Columnar option. Click on the Next button. Jacana
displays the field order dialog box.

√ Choose the order you want the fields shown in. Click on each field
and then on the > button. Choose the fields in this order:

» Warehouse identifier

» Full warehouse description

» Product description

» Product number

» Quantity currently on hand

» Purchase price for this product.
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Here you decide the report will be clearer if the warehouse and its
description are printed in the headings, rather than on each line of the
report.

√ Click on the Full warehouse description field.

√ Click on the Advanced Output button. Jacana displays the
advanced output dialog box.

√ Click on the Break tab. Jacana displays the break options.

√ Choose the Print this field in the page headings option. Now this
field will print in each page’s headings when the report is run.

√ Choose the And all fields earlier in the output order option. Now all
the preceding fields will also appear in the page headings. This
means the warehouse identifier and description will be shown at
the top of each page making it easier to read the report.

√ Choose the Start a new page when the value of this field changes
option. Usually when printing fields in the headings you set this
option for at least one field in the headings, often a sort field. This
means the output will start a new page when this particular field
changes value.

√ Click OK. Jacana returns to the field order dialog box.

BU]_fU�bUTe^TQ^d�d_dQ\c

Here you suppress printing of totals on change of product description.
This is because product description is likely to change on each line of
the report and summarized totals will be redundant.
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√ Click on the Product description field.

√ Click on the Advanced Output button. Jacana displays the
advanced printing dialog box.

√ Click on the Break tab. Jacana displays the break options.

√ Click on the Print or display totals when the value of this field
changes option. Now you have turned off this option (removed the
check) and the report will not include totals for this field every time
it changes.

√ Click OK. Jacana returns to the field order dialog box.

√ Click on the Next button. Jacana displays the title dialog box.

√ Enter a title for your report. Enter the name JACxxx02, where xxx
are your initials and the title Jacana exercises.

√ Click on the Finish button. The ReportWizard will now create your
report definition, based on the answers you gave.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx02.REP, where xxx are your
initials.

µ Save your exercise files locally (on your PC). Choose the Local tab
from the Save dialog box.

√ Choose the Close option from the File menu.

This completes exercise two. You have now created another report
definition using the ReportWizard function. You have used some of the
advanced features of the ReportWizard to customize your report.
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Objective: Enhance the appearance of the report from exercise two.
On completion of this exercise, the report should look similar to
this:

JACiii03XX        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX       Page 99999
User . . . . . . : XXXXXXXXXX                             HH:MM:SS DD/MM/YY

Warehouse ID . . . :  XXXXX
Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                               Product               Product  Date of
  Product                       Number    Quantity  Purchase   Last
Description                    Identity    On hand   Price   Stocktake
-----------                    --------   --------  -------- ---------
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-   99/99/99
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-   99/99/99
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-   99/99/99
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-   99/99/99
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-   99/99/99
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-   99/99/99
Total for this warehouse                999999999-
Report total                            999999999-

JACiii03XX        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX       Page 99999
Note: Guide only. Some characters not positioned exactly.

New concepts:

• Copying reports

• Changing the report’s appearance using Layout

• Using the DataCrafter

• The control group of fields

• Changing the format for fields

3_`iY^W�bU`_bdc

√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

√ Choose the report definition you created in the last exercise,
JACxxx02.REP, from the drop-down list.
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µ Use this option to create a new report definition based upon the one
you created in the previous exercise. It means you will still have the
report definition you created in the previous exercise and a copy to
change for this exercise.

√ Click OK. Jacana displays the report definition.

3XQ^WY^W�dXU�bU`_bdµc�Q``UQbQ^SU�ecY^W�<Qi_ed

Here you will change the appearance of the report to learn some of the
features offered by Jacana including bold type, inserting text and
changing line spacing.

√ Click on the heading line containing the Warehouse desc.

√ On the layout toolbar, change the space before from 2 to 1.

This adjusts the spacing before this line and in this example means
the warehouse ID and warehouse description will be printed closer
together.

√ Click on the Warehouse ID field in the Layout window.

√ Click on the bold button on the layout toolbar. 
This means the Warehouse ID field will be printed in bold letters.

√ Click on the Warehouse description field in the Layout window.

√ Click on the bold button on the layout toolbar. This means this field
will also be printed bold.

√ Click on the left (position 1) of the Change of warehouse line in the
layout window (this is the line showing the first total).

µ The line type is shown in the Layout toolbar.

√ Check to see that you are in over-type mode (the OVR indicator on
the status bar should not be grayed). If you are in insert mode,
press the Insert key to change to overtype mode. Notice how the
cursor changes when the over-type mode changes. If you are in
insert mode, and you type text or add a field, all the fields after the
cursor location on that line will be moved to the right.

√ Type the text Total for this warehouse. By adding text to your
report definition you can make the report output much easier to
read and understand.
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√ Click on the left of the Report level in the layout window (this is the
line showing the second or overall total).

µ Use the scroll bars to move around your report layout.

√ Type the text Report total.

Warehouse ID . . . :  XXXXX
Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                               Product               Product
  Product                       Number    Quantity  Purchase
Description                    Identity    On hand   Price
-----------                    --------   --------  --------
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX  XXXXXX    9999999- 99999.99-

Total for this warehouse                999999999-
Report total                            999999999-

EcY^W�dXU�4QdQ3bQVdUb

Here you will find fields from the data source for printing in your
report where you want it. All fields currently in the report were placed
by the ReportWizard.

√ Click on the Standard Fields button in the DataCrafter. 
Jacana displays fields which should common to all data sources.
This includes fields such as page number, Number of Pages.
Jacana updates the picking list in the DataCrafter.

√ Scroll the DataCrafter until you find the Name of user who initiated
AS/400 job field.

√ Click on this field and use the right mouse button to drag-and-drop
it into column one of the second line of your report layout

√ Choose the Field and label option from the shortcut menu.
You gave just added the user’s name to the report definition. This
means when the report is run the user’s name is included in the
report output.
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√ Enter the text dat into the Pick Fields Containing box in the
DataCrafter.

√ Press the Enter key. Jacana updates the picking list in the
DataCrafter.
You have just chosen all the fields containing the text ‘dat’ in long
text description.

1TTY^W�Q�^Ug�S_\e]^�Y^�dXU�bU`_bd�TUdQY\�\Y^U

√ Use the right mouse button to drag-and-drop the Date of last
physical stocktake field into your report layout. Place it to the right
of Product purchase price in the detail line, so as to make a new
column.

√ Choose the Field and heading option from the shortcut menu. You
gave just a new column to the report. This will contain the date this
product in that warehouse was last included in a physical
stocktake.

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

           Product               Product  Date of
            Number    Quantity  Purchase   Last
           Identity    On hand   Price   Stocktake
           --------   --------  -------- ---------
XXXXXXXXXX  XXXXXX    9999999- 99999.99-   999999-
XXXXXXXXXX  XXXXXX    9999999- 99999.99-   999999-
XXXXXXXXXX  XXXXXX    9999999- 99999.99-   999999-
XXXXXXXXXX  XXXXXX    9999999- 99999.99-   999999-
XXXXXXXXXX  XXXXXX    9999999- 99999.99-   999999-
XXXXXXXXXX  XXXXXX    9999999- 99999.99-   999999-

ouse                999999999-
                    999999999-



:QSQ^Q
8Q^Tc�_^ UhUbSYcUc

@QWU :�!$( :QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

3XQ^WY^W�dXU�V_b]Qd�V_b�VYU\Tc

√ Use the right mouse button to click on the Date of last physical
stocktake field in the Layout window. Jacana displays a shortcut
menu.

√ Choose the Format Field option from the shortcut menu.

√ Click on the Editing tab.

√ Choose the Date option. This will insert separators between the
day, month and year.

√ Click OK.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx03.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise three. You have now created a new report
definition by using a copy of a previous report definition. You have
filtered the picking list, used the DataCrafter and worked with the
report layout.

V 5hUbSYcU�6_eb

Objective: Modify the report from exercise three to calculate and
print Margin on Quantity on Hand. On completion of this
exercise, the report should look similar to this:

JACiii04X        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX        Page 99999
User . . . . . . : XXXXXXXXXX                             HH:MM:SS DD/MM/YY

Warehouse ID . . . :  XXXXX
Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                          Product            Product  Date of       Margin
  Product                  Number  Quantity Purchase   Last        Quantity
Description               Identity  On hand  Price   Stocktake      on hand
-----------               -------- -------- -------- ---------     --------
XXXXXXXXXXXXXXXXXXXXXXXX   XXXXXX  9999999- 99999.99-  99/99/99   99999.99-
XXXXXXXXXXXXXXXXXXXXXXXX   XXXXXX  9999999- 99999.99-  99/99/99   99999.99-
XXXXXXXXXXXXXXXXXXXXXXXX   XXXXXX  9999999- 99999.99-  99/99/99   99999.99-
XXXXXXXXXXXXXXXXXXXXXXXX   XXXXXX  9999999- 99999.99-  99/99/99   99999.99-
XXXXXXXXXXXXXXXXXXXXXXXX   XXXXXX  9999999- 99999.99-  99/99/99   99999.99-
XXXXXXXXXXXXXXXXXXXXXXXX   XXXXXX  9999999- 99999.99-  99/99/99   99999.99-
Total for this warehouse         999999999-                     9999999.99-
Report total                     999999999-                     9999999.99-

JACiii04X        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX        Page 99999
Note: Guide only. Some characters not positioned exactly.
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New concepts:

• Calculation fields

• Change field properties

7UddY^W�cdQbdUT

√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

√ Choose the report definition you created in the last exercise,
JACxxx03.REP, from the drop-down list.

√ Click OK. Jacana displays the report definition.

3Q\Se\QdY_^�VYU\Tc

Here you will create a field which is calculated from other fields and
include that field in your report.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.

√ Click on the Calculate tab

.
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Here you are looking for the field Selling price.

√ Enter the text sel into the Pick Fields Containing box in the
DataCrafter.

µ Drag the Specifications dialog box out of the way if the button is
obscured.

√  Press the Enter key. Jacana updates the picking list in the
DataCrafter.

√ Use the left mouse button to drag-and-drop Selling price for this
product field into the Calculate list box.

6YU\T�`b_`UbdYUc

You have now created a calculation field. Here you will set the fields
properties such as field description.

√ Click on the Properties button. Jacana displays the Properties
dialog box. You can specify a field’s settings using this dialog box.

√ Click on the Text tab.
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√ Enter the following text into the appropriate box.

In this box Enter this text

Description Margin on Quantity on Hand

Left text Margin - Qty on Hand

Right text Margin - Qty on Hand

Headings Margin
Quantity
on Hand

µ Use the Tab key to move between the text boxes.

√ Click OK. Jacana returns to the Specifications dialog box.

2eY\TY^W�dXU�SQ\Se\QdY_^�Uh`bUccY_^

√ Click on the Calculation builder button. 
Jacana displays the Calculation builder dialog box. You can use this
dialog box to build complex calculations.

√ Click on the Working List button in the DataCrafter. 
Jacana displays the working list of fields in the DataCrafter.

√ Build this expression by dragging in fields from the DataCrafter
and by using the buttons on the Calculation builder dialog box.

( &selp - &purp ) * &qohd
This is: selling price minus purchase price multiplied by quantity
on hand.

√ Click OK to complete the calculation. You have just created a
workfield that calculates margin on the quantity on hand.
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√ Click on the Close button to close the Specifications dialog box.

√ Click on the Pick Calculations button on the DataCrafter. 
Jacana lists the calculated workfields in the DataCrafter.

√ Check to see that you are in insert mode (the OVR indicator on the
status bar should be grayed).

√ Use the right mouse button to drag-and-drop Margin on quantity on
hand field into your report layout. Place it next to Date of last
physical stocktake in the detail line, so as to make a new column.

√ Choose the Field, heading and totals option from the shortcut
menu. You have just added a new column to the report. This is the
field you have just calculated. The heading text comes from the
properties you set. Note that Jacana re-positioned the new column
to allow for the totals to be included.

Product   Date of       Margin
Purchase   Last        Quantity
 Price    Stocktake     on hand
--------  ---------    --------
99999.99-  99/99/99   99999.99-
99999.99-  99/99/99   99999.99-
99999.99-  99/99/99   99999.99-
99999.99-  99/99/99   99999.99-
99999.99-  99/99/99   99999.99-
99999.99-  99/99/99   99999.99-

                    9999999.99-
                    9999999.99-

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx04.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise four. You have now created a new report
definition by using a copy of a previous report definition. You have seen
the Specifications dialog box. You used the Specifications dialog box to
create calculated workfields. You also saw how to change the properties
of fields.
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Objective: Modify the report from exercise four to indicate when
stock should be reordered. On completion of this exercise, the
report should look similar to this:

JACiii05X        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX        Page 99999
User . . . . . . : XXXXXXXXXX                             HH:MM:SS DD/MM/YY

Warehouse ID . . . :  XXXXX
Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                    Product           Product  Date of    Margin
  Product            Number Quantity Purchase   Last     Quantity Reorder?
Description        Identity  On hand  Price   Stocktake   on hand  YES/NO
-----------        -------- -------- -------- ---------  -------- --------
XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
Total for this warehouse  999999999-                   9999999.99-
Report total              999999999-                   9999999.99-

JACiii05X        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX        Page 99999

Note: Guide only. Some characters not positioned exactly.

New concepts:

• creating a conditioned calculation

• cut and paste

• undo and redo

7UddY^W�cdQbdUT

√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

√ Choose the report definition you created in the last exercise,
JACxxx04.REP, from the drop-down list.

√ Click OK. Jacana displays the report definition.
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Here we will find the reorder level field to use as the basis for creating
the condition Product needs reordering.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.

√ Click on the Calculate tab.

√ Hold the Shift key and click on the New Calculation button .
Holding the Shift key makes Jacana not use the default Show
Calculation Builder for new calculation setting (see Jacana
options). Before going to the Calculation Builder we need to change
the field type.

√ Click on the character button . Jacana changes the new work-
field from numeric to character.

√ Click on the Properties button. Jacana displays the Properties
dialog box.

√ Click on the Text tab.

√ Enter the following text into the appropriate box.

In this box Enter this text

Description Reorder? YES/NO

Left text Reorder? YES/NO

Right text Reorder? YES/NO

Headings Reorder?
YES/NO

µ The Left and Right text will be automatically generated. You will
need to change the column headings as punctuation characters will
not be automatically inserted.

√ Click on the General tab. You can use this tab to set the size and
type of field.
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√ Change the Size of the field to 3. You have just changed this field to
an alphanumeric field 3 characters long.

 

√ Click OK. Jacana returns to the Specifications dialog box.

√ Click on the Calculation builder button. 
Jacana displays the Calculation builder dialog box.

√ Enter the text ‘NO’ into the Expression box.
At this stage, the Calculation field will always be set to ‘NO’, which
is not really useful.

µ Notice Jacana automatically sets the Caps Lock setting on the
keyboard when typing between quotes. If this feature is not to your
liking, you can turn off this feature via the Options dialog.
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Here you will add conditions to the calculation field.

√ Click on the Conditioned button.
Jacana expands the Calculation Builder dialog.

√ Click on the Add button
Jacana shows the Condition Builder dialog.

√ Enter the text quantity into the Pick Fields Containing box in
the DataCrafter.

√ Press the Enter key. Jacana updates the picking list in the
DataCrafter.

√ Build this expression by dragging in fields from the DataCrafter
and by using the buttons on the Condition builder dialog box.

*if &qrol >= &qohd *or &qohd <= &qord
This is: The condition is true if the reorder level is greater than or
equal to quantity currently on hand or the quantity currently on
hand is less than or equal to quantity committed to fill orders.



:QSQ^Q
8Q^Tc�_^ UhUbSYcUc

:QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

@QWU :�!%'

√ Click OK to complete the condition. You have just created a
condition that determines if it is necessary to re-order a product.

Jacana returns to the Calculation Builder dialog box, ready for you
to type an expression associated with this condition.

√ Enter the text ‘YES’ into the Expression box.

µ When a condition is chosen in the conditions list, the expression
edit box shows the related expression
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µ When running a report the conditions are evaluated from the top of
the list.
The first condition which is true is used to set the value of the
calculation field.
If no conditions are true, the expression associated with else is used.

√ Click OK. Jacana displays the Specifications dialog box.

√ Click on the Close button.

EcY^W�dXU�SQ\Se\QdY_^�VYU\T

√ Click on the Pick Calculations button in the DataCrafter.
Jacana displays the calculated workfields in the DataCrafter.

√ Use the right mouse button to drag-and-drop Reorder? YES/NO
field into your report layout. Place it between Date of Last Stocktake
and Margin quantity on hand on the detail line, so as to make a
new column.

µ Make sure mode is insert, not overtype.

√ Choose the Field and heading option from the shortcut menu.
You have just added a new column to the report. This is the
conditional calculation you specified. When the report is run it will
calculate if the condition is true or false for each product listed. If it
is true it will print YES (to reorder) and if it is false it will print
NO.

EcY^W�Sed�Q^T�`QcdU

Let us assume you are not happy with where you placed the Reorder
field. You will now move it to the right of Margin quantity on Hand.

√ With your mouse, lassoe the gray area shown below.

  Date of
   Last
 Stocktake
  99/99/99
  99/99/99
  99/99/99
  99/99/99
  99/99/99
  99/99/99

 
 Reorder?
  YES/NO

 XXX
 XXX
 XXX
 XXX
 XXX
 XXX

   Margin
  Quantity
   on hand
  --------
 99999.99-
 99999.99-
 99999.99-
 99999.99-
 99999.99-
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√ Click on the cut button.

µ Make sure layout is in insert mode. When in insert mode, data to
the right of the insertion point is moved to accommodate the
insertion or deletion. In overtype mode no adjustment occurs.

√ Click on the paste button.  Jacana shows a tracker that indicates
the affect of the pending paste.

√ Move the mouse cursor to the right of Margin in the first column
heading line and click to complete the paste action.

EcY^W�e^T_�bUT_

Let us assume you are in two minds about the report layout.

√ Click on the down arrow button for multiple undos.

√ Choose to undo the last two actions.

No. It was better the way it was.

√ Click on the down arrow button for multiple redos.

√ Choose to redo the last two undone actions.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx05.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise five. You have now seen more of the
Specifications dialog box. You used the Specifications dialog box to
create conditioned calculated workfields. You also saw how to further
change the properties of fields.
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Objective: Modify the report from exercise five to select

♦ on certain default warehouses

♦ products in a specified range

♦ only products which are committed to fill orders

 The report should be also print the selection criteria for product
number. On completion of this exercise, the report should look
similar to this:

 JACiii06X        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX        Page 99999
 User . . . . . . : XXXXXXXXXX                             HH:MM:SS DD/MM/YY
 From product # XXXXXX To product # XXXXXX
 
 Warehouse ID . . . :  XXXXX
 Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                     Product           Product  Date of    Margin
   Product            Number Quantity Purchase   Last     Quantity Reorder?
 Description        Identity  On hand  Price   Stocktake   on hand  YES/NO
 -----------        -------- -------- -------- ---------  -------- --------
 XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
 XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
 XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
 XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
 XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
 XXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX
 Total for this warehouse  999999999-                   9999999.99-
 Report total              999999999-                   9999999.99-
 
 JACiii06X        XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX        Page 99999

 Note: Guide only. Some characters not positioned exactly.
 

 New concepts:

• more on selecting data

• the run-time interface

• inserting lines in layout

7UddY^W�cdQbdUT

√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

√ Choose the report definition you created in the last exercise,
JACxxx05.REP, from the drop-down list.
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√ Click OK. Jacana displays the report definition.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.

=_bU�_^�cU\USdY^W�TQdQ

Here you will make the report select products only for specified
warehouses.

√ Click on the Select tab.

√ Click on the Select builder button. 
Jacana displays the Select builder dialog box.
You can use this dialog box to specify what fields the user will use
to select or omit records for their report.

√ Build this expression by dragging in fields from the DataCrafter
and by using the buttons on the Select builder dialog box.

*if &whid = ‘BRIS1’?
*or &whid = ‘BIRM1’?

µ If the last character in a select/omit field is ‘?’, when a user runs the
report, they will be prompted to accept, change or remove the
select/omit value.

 

µ Notice the Matching records indicator is set to the default, Select.
To omit records, you would click on the Omit option.
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√ Click OK to complete the select/omit criteria. Jacana displays the
Specifications dialog box.

Here you will make the report select products only if some of the stock
is committed to fill customer orders.

√ Click on the Working List button in the DataCrafter. Jacana
displays the working list of fields in the DataCrafter.

√ Use the left mouse button to drag-and-drop the Quantity committed
to fill orders field into the Select list box

√ Edit the expression shown below the list to read
*if &qord > 0

This selection test will automatically select product records that
have a quantity committed to fill orders greater than zero. The user
will not be prompted as there is no ? in the expression.

Here you will make the report select products in a given range.

√ Use the left mouse button to drag-and-drop the Product number
field into the Select box.

√ Click on the Select builder button. Jacana displays the Select
builder dialog box.

√ Use the Backspace key to remove the ‘= ?’.

√ Click on the range button, <> and then the ? , ? buttons to build the
expression.
The ? , ? means that when a user runs the report, they will be
prompted for the two values setting the range of product numbers
to include in their report. If the user does not specify a range, all
products will be selected.
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√ Click OK to complete the select/omit criteria. Jacana displays the
Specifications dialog box.

√ Click on the Close button.

@bY^d�dXU�cU\USdY_^�SbYdUbYQ�V_b�`b_TeSd�bQ^WU

√ Click on the second line of the report (the one showing the user
name).

√ Click on the insert line after button on the layout toolbar .
This will insert another header line into the report layout, below
the current line.

√ Click on the Pick Selection Values button in the DataCrafter. 
Jacana displays the selection fields in the DataCrafter.

√ Use the left mouse button to drag-and-drop the Selection value 1 for
product number field into your report layout. Place it on the newly
inserted line. Repeat for Selection value 2 for product number field.

√ Add text to the product number ranges.
From product # XXXXXX To product # XXXXXX
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The run-time interface shows the text or prompts that will be shown to
the user when the report is run. You can add text to these prompts so
the user has a better understanding of what they have to enter. You
can also change the order in which various values are requested.

√ Click on the Run-time Interface button. 
Jacana displays the Run-time interface dialog box.

√ Click on the SELECT Product Number line.

√ Click on the Move Up button twice. Now the first information the
user will be asked for is the range of product numbers to include in
their report.

√ Click on the SELECT Warehouse Identifier line.

√ Click on the Insert Text button. Jacana displays the Run-time text
dialog box.
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√ Enter the text
To select all warehouses, clear the next 2 selection fields.

 

µ You can use Ctrl+Enter to force a line break and move to the next
line in the Run-time text box

√ Click OK. Jacana displays the Run-time interface dialog box.

 

√ Click OK.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx06.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise six. You have now seen more of the
Specifications dialog box. You used the Specifications dialog box to
create and include select/omit selections in the report definition. You
have also edited the run-time interface.
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Objective: Modify the report from exercise six to accept a user
supplied value for price increase percentage and use this to print
a new margin on quantity on hand. On completion of this
exercise, the report should look similar to this:

JACiii07X             XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX            Page 99999
User . . . . . . : XXXXXXXXXX                                      HH:MM:SS DD/MM/YY
From product # XXXXXX To product # XXXXXX  Price increase % . : 99999.99

Warehouse ID . . . :  XXXXX
Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                  Product            Product  Date of     Margin
  Product          Number  Quantity Purchase   Last      Quantity Reorder?     New
Description       Identity  On hand  Price   Stocktake   on hand   YES/NO     margin
-----------       -------- -------- -------- ---------   -------- --------    ------
XXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-   XXX    99999.99-
XXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-   XXX    99999.99-
XXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-   XXX    99999.99-
XXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-   XXX    99999.99-
XXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-   XXX    99999.99-
XXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-   XXX    99999.99-
Total for this warehouse 999999999-                   9999999.99-
Report total             999999999-                   9999999.99-

JACiii07X             XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX            Page 99999
Note: Guide only. Some characters not positioned exactly.

New concepts:

• report parameters

7UddY^W�cdQbdUT

√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

√ Choose the report definition you created in the last exercise,
JACxxx06.REP, from the drop-down list.

√ Click OK. Jacana displays the report definition.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.
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Here you will define a field which will accept a user supplied value for
price increase percentage.

√ Click on the Parameters tab.

√ Click on the Working list button in the DataCrafter. Jacana
displays the working list of fields in the DataCrafter.

√ Use the left mouse button to drag-and-drop the Selling price for this
product field into the Parameters list box.

√ Click on the Extended definition button.  Jacana displays the
Parameter definition dialog box. You can set the prompt text and
default value for the parameter. The default value is used if the
user does not enter a value when they run the report.

√ Enter the text Price increase percent in the Prompt text box.

√ Enter the value 5.0 in the Default value box.

√ Click OK. Jacana displays the Specifications dialog box.
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√ Click on the Close button.

Here you will print the above parameter in the report heading.

√ Click on the Pick Parameters button in the DataCrafter. 
Jacana displays the parameter fields in the DataCrafter.

√ Use the right mouse button to drag-and-drop the Price increase
percent field into your report layout. Place it next to to product #
field (on the third line).

√ Choose the Field and label option from the shortcut menu.
You have just added a new piece of information to the report. This
is the price increase percent the user entered and is calculated for
the report.

Here you make a new calculation field to print the margin on quantity
on hand based on the above parameter.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.

√ Click on the Calculate tab.

√ Click on the Working list button in the DataCrafter. Jacana
displays the working list of fields in the DataCrafter.

√ Use the left mouse button to drag-and-drop the Margin on Quantity
on hand field into the Calculate list box.

√ Click on the Properties button. Jacana displays the Properties
dialog box.

√ Click on the Text tab.

√ Enter the following text into the appropriate box.

In this box Enter this text

Description New margin on quantity on hand

Left text New margin

Right text New margin

Headings New margin
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√ Click OK. Jacana returns to the Specifications dialog box.

√ Click on the Calculation builder button. Jacana displays the
Calculation builder dialog box.

√ Click on the Working List button. 
Jacana displays the working list of fields in the DataCrafter.

√ Build this expression by dragging in fields from the DataCrafter
and by using the buttons on the Calculation builder dialog box.

&parm0001 * &calc0001 / 100
This is: price increase percent multiplied by the margin on quantity
on hand divided by 100.

√ Click OK to complete the calculation. You have just created a
workfield that calculates the new margin on the quantity on hand.

√ Click on the Close button to close the Specifications dialog box.

√ Click on the Pick Calculations button on the DataCrafter. 
Jacana lists the calculated workfields in the DataCrafter.

√ Use the right mouse button to drag-and-drop the New margin on
quantity on hand field into your report layout. Place it next to
Reorder? Yes/No in the detail line, so as to make a new column.
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√ Choose the Field and heading option from the shortcut menu. You
have just added a new column to the report showing the new
margin with the price increase percent. You have now added a
‘what-if’ scenario to the report. This allows the user to see what
happens if the price is increased by a percentage that they can
enter.

 Date of      Margin
  Last       Quantity Reorder?     New
 Stocktake    on hand  YES/NO     margin
 ---------   -------- --------    ------
   99/99/99 99999.99-   XXX    99999.99-
   99/99/99 99999.99-   XXX    99999.99-
   99/99/99 99999.99-   XXX    99999.99-
   99/99/99 99999.99-   XXX    99999.99-
   99/99/99 99999.99-   XXX    99999.99-
   99/99/99 99999.99-   XXX    99999.99-

 

 Here you will add instruction to the run-time interface to aid the user
when they run this report.

√ Click on the Run-time Interface button. Jacana displays the Run-
time interface dialog box.

√ Click on the PARM Price increase percent line.

√ Click on the Insert Text button. Jacana displays the Run-time text
dialog box.

√ Enter the text Enter the price increase percentage for calculating the
new margins.

√ Click OK. Jacana displays the Run-time interface dialog box.

√ Click on the PARM Price increase percent line.

√ Click on the Move Down button until the parameter is below the
text added in the above steps.

√ Click OK.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx07.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

That completes exercise seven. You have now seen more of the
Specifications dialog box. You used the Specifications dialog box to
create and include parameters and calculated workfields in the report
definition. You have also edited the run-time interface.
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Objective: Modify the report from exercise seven to show the
maximum margin on quantity on hand. On completion of this
exercise, the report should look similar to this:

JACiii08X             XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX             Page 99999
User . . . . . . : XXXXXXXXXX                                       HH:MM:SS DD/MM/YY
From product # XXXXXX To product # XXXXXX  Price increase % . : 99999.99

Warehouse ID . . . :  XXXXX
Warehouse Desc.  . :  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
                    Product            Product  Date of    Margin
  Product            Number  Quantity Purchase   Last     Quantity Reorder?     New
Description         Identity  On hand  Price   Stocktake   on hand  YES/NO     margin
-----------         -------- -------- -------- ---------  -------- --------    ------
XXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX    99999.99-
XXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX    99999.99-
XXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX    99999.99-
XXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX    99999.99-
XXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX    99999.99-
XXXXXXXXXXXXXXXXXXX  XXXXXX  9999999- 99999.99-  99/99/99 99999.99-  XXX    99999.99-
Total for this warehouse   999999999-             Total 9999999.99-
                                                  Maximum 99999.99-
Report total               999999999-             Total 9999999.99-
Number of warehouses listed  9999999              Maximum 99999.99-

JACiii08X             XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX             Page 99999
Note: Guide only. Some characters not positioned exactly.

New concepts:

• Using other summary types
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√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the Copy an existing report option.

√ Choose the report definition you created in the last exercise,
JACxxx07.REP, from the drop-down list.

√ Click OK. Jacana displays the report definition.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.
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Here you will make the report print the maximum margins for
warehouse and for the whole report.

√ Click on the Summarize tab.

√ Click on the Margin on Quantity on Hand line.

√ Click on the Maximum button , or use the right mouse button to
click on the field and choose Maximum from the menu. This has
now added a maximum field/value that will contain the highest
value found for this field when the report is run. You can use this
summary field in your report.

√ Click on the Close button.

√ Click on the Pick Summary Fields button in the DataCrafter. 
Jacana now displays the summary fields in the DataCrafter.

µ You could use the  button to select the kind of summary fields you
want.

√ Use the left mouse button to drag-and-drop the Maximum of
margin of quantity on hand by warehouse desc. field into your
report layout. Place it beneath the first total for Margin quantity on
hand.

√ Type appropriate text next to this field, e.g. Maximum.

√ Type appropriate text next to the total field on the line above to
distinguish it from the maximum, e.g. Total.



:QSQ^Q
8Q^Tc�_^ UhUbSYcUc

:QSQ^Q BU\UQcU "�% ° 9cceU !� � =Qi !)))
� =_]U^de] EdY \ Y d YUc @di <dT

@QWU :�!'#

√ Click on the line showing report level totals.

√ Click on the insert line after button on the layout toolbar .
This will insert another report level totals line into the report
layout, below the current line.

√ Use the left mouse button to drag-and-drop the Maximum of
margin of quantity on hand for report field into your report layout.
Place it beneath the other totals for Margin quantity on hand.

√ Type appropriate text next to this field, e.g. Maximum.

√ Type appropriate text next to the total field on the line above to
distinguish it from the maximum, e.g. Total.

√ Use the layout toolbar to increase the space before this line to 2.

Here you will make the report print the number of warehouses printed
in the report

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.

√ Click on the Summarize tab.

√ Click on the Working list button in the DataCrafter.

√ Use the left mouse button to drag-and-drop the Full warehouse
description field into the Summarize list box.

√ Click on the Count unique values button. 
In this example, this will give us a count of the number of
warehouses included in the report.

µ When you ask Jacana to summarize an alphabetic field, the default
is to count the records. In this case we require the number of
unique values.

√ Click on the Records button. 
This turns off the summary value that indicates the number of
records or occurrences for this field.

√ Click on the Close button.

√ Click on the Pick Summary fields button in the DataCrafter.
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√ Use the left mouse button to drag-and-drop the Unique count of full
warehouse description for report field into your report layout. Place
it toward the left-hand side of the last report line.

√ Check to see that you are in over-type mode (the OVR indicator on
the status bar should not be grayed).

√ Type appropriate text next to this field, e.g. Number of warehouses
listed.

Report total                     999999999-          Total 9999999.99-
Number of warehouses listed        9999999           Maximum 99999.99-

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx08.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise eight. You have now seen more of the
Specifications dialog box. You used the Specifications dialog box to
create and include summary values, including totals in the report
definition.

V 5hUbSYcU�>Y^U

Objective: Create a stock valuation report by warehouse area in a
matrix grid. On completion of this exercise, there should be two
reports that should look similar to these:

JACiii09X              XXXXXXXXXXXXXXXXMatrix viewXXXXXXXXXXXXX               Page 99999
                                                                       HH:MM:SS DD/MM/YY

                      2                   3                 *OTHER              X-Total
Product       2    Extended       3    Extended    *OTHER  Extended    X-Total Extended
 Number   Quantity Selling    Quantity Selling    Quantity Selling    Quantity Selling
Identity  On hand   Price     On hand   Price     On hand   Price.    On hand   Price
--------  -------  --------   -------  --------   -------  --------   -------  --------
 XXXXXX   99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-
 XXXXXX   99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-
 XXXXXX   99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-
 XXXXXX   99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-
 XXXXXX   99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-
 XXXXXX   99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-  99999- 9999999.99-

JACiii09X              XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX               Page 99999
Note: Guide only. Some characters not positioned exactly.
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JACiii09X              XXXXXXXXXXXXXXXXSimple viewXXXXXXXXXXXXX               Page 99999
                                                                       HH:MM:SS DD/MM/YY

Product   Warehouse           Extended
 Number     Post     Quantity  Selling
Identity    Code     On hand   Price
--------  --------   -------  --------
 XXXXXX     XXXX     99999- 9999999.99-
 XXXXXX     XXXX     99999- 9999999.99-
 XXXXXX     XXXX     99999- 9999999.99-
 XXXXXX     XXXX     99999- 9999999.99-
 XXXXXX     XXXX     99999- 9999999.99-
 XXXXXX     XXXX     99999- 9999999.99-

JACiii09X              XXXXXXXXXXXXJacana ExercisesXXXXXXXXXXXX               Page 99999
Note: Guide only. Some characters not positioned exactly.

New concepts:

• Matrix columns

• Multi-sheet reports
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√ Click on the New button or choose the New option from the File
menu. Jacana displays the New Report dialog box.

√ Choose the ReportWizard option. Click OK.

√ If Jacana shows the Choose Wizard dialog box, choose the standard
ReportWizard and click OK

√ Jacana displays the first ReportWizard dialog box.

√ Click on the Next button. Jacana displays the data selection dialog
box.

√ Select the DEMOINVENT data source from the drop down list.

µ If this data source is not shown on the drop down list, click on the
Choose Data button. Jacana displays the Choose Data dialog box.
Choose the Subset tab. Choose the DEMOINVENT subset. Click
OK.

√ Click on the Next button. Jacana displays the fields dialog box.

√ Add the following fields to the working list:

» Product number

» Quantity currently on hand
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» Extended selling price

» Warehouse Post code

√ Click on the Next button. Jacana displays the next dialog box. You
have now finished choosing the fields to include in your report.

√ Click on the Next button. Jacana displays the sorting dialog box.

√ Double-click on the Product number field. You have now specified
data in this report is sorted by product number down the page.

√ Click on the Next button. Jacana displays the select/omit dialog
box.

√ Click on the Next button. There is no select/omit in this exercise.
Jacana displays the totals dialog box.

√ Click on the Next button. It is not necessary to specify totals with
matrix style reports. Jacana displays the next dialog box.

=QdbYh�c`USYVYSQdY_^c

√ Click on the Next button. Choose the option Yes for matrix
columns.

√ Click on the Next button. Jacana displays the matrix column
condition field dialog box.

The matrix column condition field is used to create conditions that will
make multiple columns. In this exercise you will use Warehouse Post
code.

√ Double-click on Warehouse Post code.

√ Click on the Next button. Jacana displays the matrix column
condition dialog box.

The column conditions are:

♦ Warehouse Post code starts with 2

♦ Warehouse Post code starts with 3

♦ All other post codes
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√ Specify the following in the first two rows:

 Row  Operator  Value

 1  ST  2

 2  ST  3

µ To Enter ST, you will need to choose it from the pull-down list.

√ In the third row of conditions, click on the condition builder button.

 Jacana displays the Advanced Matrix Condition dialog box. You
can use this dialog box to build complex conditions.

√ Click on Condition Equal to.

√ Click on Compare Value(s) Other values.

√ Click OK. Jacana displays the matrix column condition dialog box.

√ Click on the Next button. Jacana displays the matrix column fields
dialog box.

Each matrix column condition has a column for Quantity currently on
hand and a column for Extended Selling price.

√ Double-click on Quantity currently on hand.

√ Double-click on Extended Selling price.

√ Click on the Next button. Jacana displays the next dialog box.

√ Click on the Next button. Jacana displays the output dialog box.

√ Choose the Print option. Click on the Next button. Jacana displays
the details dialog box.

Detail is not needed on this report. You only need to show figures
summarized for Product number.

√ For matrix reports, the default is to summarize data. The level
shown is Product number, which is what you want. Click on the
Next button. Jacana displays the style dialog box.

√ Choose the Columnar option.

√ Click on the Next button. Jacana displays the field order dialog
box.
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The matrix column fields have already been chosen for output. These
are shown already in the Field output order.

√ Double-click Product number to print in your report:

√ Click on the Next button. Jacana displays the title dialog box.

√ Enter a title and name for your report. Enter the name JACxxx09,
where xxx are your initials and the title Jacana exercises.

√ Click on the Finish button. The ReportWizard will now create your
report definition based on the answers you gave. Jacana displays
your report definition.

=e\dY�cXUUd�bU`_bdc

Now you will add a second sheet to the report that prints from the
same extracted data, but prints a simple layout instead of a matrix
layout.

6Ybcd�WYfU�dXU�SebbU^d�cXUUd�Q�^Ug�^Q]U�

√ Click on the Sheets button in the toolbar.  Jacana displays the
sheets dialog.

√ Click on the Sheets button. Jacana displays a menu.

√ Click on the Properties menu item. Jacana displays the Sheet
Properties dialog.

√ Click on the General tab and type Matrix view in the sheet
description edit box.

√ Click on the OK button.

3bUQdU�Q�^Ug�cXUUd�

√ Click on the Sheets button. Jacana displays a menu.

√ Click on the New menu item. Jacana displays the New Sheet
dialog.

√ Click on the LayoutWizard option.
NOTE: All the sheets of a report share the same specifications,
including sorting, summary and matrix. This is why a
LayoutWizard is shown and not a ReportWizard.
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√ Click on the OK button.

√ If Jacana shows the Choose Wizard dialog box, choose the standard
LayoutWizard and click OK

Jacana starts the wizard.

√ The output medium is not changed. Click on the Next button.

√ This sheet will show detail records. Choose Yes and click on the
Next button.

√ The output style is not changed. Click on the Next button.

√ This sheet will not use the report matrix. Choose No and click on
the Next button.

√ Click on the >> button, selecting all the fields for output and click
on the Next button.

√ Type Simple View in the sheet description edit box.

√ Click on the Finish button. Jacana creates the new sheet.

√ Choose Cascade from the Window menu. You will see the report
has now two windows for this report. One is showing the matrix
view, the other the simple view.

Now we have created the second sheet, we realize we don’t wish to
show any records with no stock.

√ Click on the Specifications button or choose the Specifications
option from the Report menu. Jacana displays the Specifications
dialog box.

√ Click on the Select/Omit tab.

√ Type On hand into the Pick Fields Containing box in the
DataCrafter.

√ Use the left mouse button to drag-and-drop Quantity currently on
hand field into the Select/Omit list box.

√ Change the select expression from *if &qohd = ? to *if &qohd > 0?.
NOTE: This selection rule applies to all sheets in the report.

√ Click on the Close button to close the specifications dialog.
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When a report is run, and no data is found, you can define a special
sheet to explain why the other report sheets do not print. To achieve
this, a null report sheet is used. Null report sheets only print when no
data is selected. When this occurs, a null sheet is printed for each of
the other report sheets.

√ Click on the Sheets button in the toolbar.  Jacana displays the
sheets dialog.

√ Click on the Sheets button. Jacana displays a menu.

√ Click on the New menu item. Jacana displays the New Sheet
dialog.

√ Click on the Blank sheet using output medium option.

√ Click on the OK button. Jacana creates a blank sheet.

√ Click on the first column heading line.

√ Click on the line properties button.

√ Click on the Print on line option and change the line number to 20.

√ Click on the OK button. Jacana closes the line properties dialog.

√ Type the text No data to report for quantity on hand greater than in
the current line.

√ Click on the Click Selection Values button in the DataCrafter.

√ Use the left mouse button to drag-and-drop Selection value 1 for Qty
On Hand field onto the current line.

No data to report for quantity on hand greater than 9999999-

√ Click on the next column heading line. Click the Delete line button
five times to delete each of the remaining column heading lines, the
detail lines and the report totals line.

√  Click on the Sheets button in the toolbar.  Jacana displays the
sheets dialog.

√ Click on the Sheets button. Jacana displays a menu.

√ Click on the Null report sheet menu item. The red dot over the
printer icon in the sheet list indicates this report is a null report
sheet.
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√ Click on the Close button.

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx09.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise nine. You have now created a matrix style
multi-sheet report.

V 5hUbSYcU�dU^

Objective: Create a file report showing product stock levels. The
output should be suitable for downloading to a spreadsheet
application on a PC.

New concepts:

• Using PC file as an output medium.

• Record layout view.

7UddY^W�cdQbdUT

√ Click on the New button or choose the New option from the File
menu. Jacana displays the Jacana dialog box.

√ Choose the ReportWizard option. Click OK.

√ If Jacana shows the Choose Wizard dialog box, choose the standard
ReportWizard and click OK

√ Jacana displays the first ReportWizard dialog box.

√ Click on the Next button. Jacana displays the data selection dialog
box.

√ Select the DEMOINVENT data source from the drop down list.
Click on the Next button. Jacana displays the fields dialog box.

√ Choose the fields to include in the report definition. Include these
fields in this order:
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» Warehouse identifier

» Full warehouse description

» Product description

» Product number

» Quantity currently on hand

√ Click on the Next button. Jacana displays the next dialog box. You
have now finished choosing the fields to include in your disk report.

√ Click on the Next button. Jacana displays the sorting dialog box.

√ Sort the disk report by Warehouse identifier and the Product
description fields.

√ Click on the Next button. Jacana displays the select/omit dialog
box.

√ Double-click on the Warehouse identifier field. You have now
specified that when a user asks for this disk report to run, they will
be prompted to choose which warehouse to include.

√ Click on the Next button. Jacana displays the totals dialog box.

√ Double-click on the Quantity currently on hand field. You have now
specified that the report will include totals for the quantity on
hand.

√ Click on the Next button. Choose the option for No matrix columns.
Jacana displays the next dialog box.

√ Click on the Next button. You have now finished the specifications
part of the ReportWizard.

√ Click on the Next button. Jacana displays the output dialog box.

√ Choose the Format for PC download option.

√ Choose the Microsoft Excel Symbolic Link PC format (.XLK). You
have now specified the report output is to be formatted for use with
Microsoft Excel. Click on the Next button. Jacana displays the
details dialog box.

√ Choose the No, summarize to level option

√ Choose to summarize to level Product description.

√ Click on the Next button. Jacana displays the field order dialog
box.
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√ Choose the order you want the fields shown in. Since you chose the
fields in a specific order initially, click on the >> button. This
chooses all the fields.

√ Click on the Next button. Jacana displays the title dialog box.

√ Enter a title for your report. Enter the name JACxxx10, where xxx
are your initials and the title Jacana exercises.

√ Click on the Finish button.

The ReportWizard will now create your disk report definition, based on
the answers you gave. You will notice the report does not use the
familiar Page layout view, but Record layout view.

You now reconsider. You no longer want to show Warehouse description
and you want Product number before Product description.

√ Click on field Warehouse description line in the field name column.

√ Click on the Delete field button in the layout toolbar. 

√ Click on field Product number.

√ Click on the Move field up button in the layout toolbar. 

√ Click on the Save button or choose Save from the File menu. Save
your report definition as JACxxx10.REP, where xxx are your
initials.

√ Choose the Close option from the File menu.

This completes exercise ten. You designed a report for PC download
and used Record Layout View for designing you output.
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When you install Jacana, the following files are copied onto your PC’s
hard disk.

Filename Directory
installed in

Description

JACANA.EXE Jacana Jacana main program

JACANA.HLP Jacana Jacana on-line help

JACANA.RET Jacana Jacana report template used for
creating new reports

JACADMIN.EXE Jacana Jacana settings for adminstrators

JACADMIN.HLP Jacana Jacana settings help

OXG4100.ENU Jacana Vendor specific resources used by
Jacana (English(US))

OXG4101.ENU Jacana Resources used by Jacana and Jacana
wizards (English(US))

OXG4102.DLL Jacana Common classes and functions

OXG4103.DLL Jacana ReportWizard

OXG4104.DLL Jacana Jacana server for AS/400

OXG4109.DLL Jacana EBCDIC/ASCII conversion

OXG4109.MAP Jacana EBCDIC/ASCII conversion table
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Filename Directory
installed in

Description

OXG4107.DLL Jacana Jacana settings

OXG4108.DLL Jacana Jacana settings for host product server

MFC40.DLL Windows
system1

Microsoft Foundation Classes

MSVCT40.DLL Windows
system1

C runtime library

HDK3AN32.DLL Windows2 Used with distributed .hlp files

HDK3CT32.DLL Windows2 Used with distributed .hlp files

1. These Microsoft  redistributeable files will only be installed if the
file is not found or is found to be an earlier version.

2. These HDK redistributeable files will only be installed if the file is
not found or is found to be an earlier version.

?dXUb�VY\U�Y^V_b]QdY_^

♦ The default setting for storing locally saved report definitions is a
sub-directory called LOCAL, e.g., C:\JACANA\LOCAL.

♦ Jacana uses the default extension .REP for locally saved report
definitions.

♦ If the report name in the server product was longer than eight
characters, when it is saved locally the name is truncated

♦ Jacana creates a file for each server system you connect to. These
have the extension .SYS.

♦ Jacana creates a file for each data source you use. These have the
extension .DTA.

♦ Jacana creates a file for global data (function and print macros) for
each host product library. These have the extension .GLB.

♦ Files installed into your Windows directory are supplied from
Microsoft C++ Version 4.0 or later.
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� $
$$LICENSE command, 12

� A
About this guide, 1
Adding

fields into your report definition, 58
sheets, 92
text to your report definition, 61

Advanced tasks, 101
All about Jacana, 17
AS/400

selecting, 52
Averages, 71

� B
Banner page, 91
Basic tasks, 49
Basics

reportings, 4
Before installing Jacana, 11
Buttons, 20

� C
Calculate tab, 72
Calculation Builder

dialog box, 74
Calculations, 72
Changing

your output settings, 114
your server, 122

Characters per inch. See Output settings
Checking

the field properties, 108

the report properties, 111
version, 126
your data source, 106

Choosing
and locating toolbars, 25
the fields to use, 57

Columns
matrix, 82

Communications
protocol, 12, 43

Condition builder, 76
Condition Builder

dialog box, 77
Conditioning

line, 95
Connection

Set AS/400 server, 27
Connection Wizard, 42
Control page, 91
Conventions, 3
Creating

a new report definition, 50
a report template, 121

� D
Data menu, 36
Data source, 9

checking the, 106
creating a report definition from, 52

Data toolbar, 24
Databases, 4

fields, 6
files, 5

DataCrafter, 18
Changing size, 18

Definitions, 9
Disk, 117
Download

PC, 118
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� E
Edit menu, 28
Editing the run-time interface, 119
Error messages, 123
Exercises, 129
Exit, 45
Exiting Jacana, 45

� F
Field

appearance, 97
properties, 108

Fields, 4
adding into a report definition, 58
choosing, 57
past right boundary, 61
removing, 61

File menu, 26
Files, 4

Jacana, 184
Filtering the picking list, 102
Filters

Quick, 49, 101
using, 101
using QuickFilters, 102

Form type. See Output settings
Full screen mode, 31

� G
Getting results, 49
Groups, 105

� H
Hands-on exercises, 129
Help, 3

menu, 39
on-line, 3

Hold output. See Output settings
How to

install Jacana, 14
use this guide, 2

� I
Incompatible levels, 124
Installing Jacana, 14

custom, 15
default, 15

Insufficient memory, 124

� J
Jacana

all about, 17
exiting, 45
files, 184
installing, 14
starting, 40
starting for the first time, 41
templates, 121
Using - advanced tasks, 101
Using - an introduction, 40
Using - basic tasks, 49
What is it?, 8
window, 17

� K
Keyboard shortcuts, 46

� L
Layout

menu, 33, 35
window, 18

Layout toolbar
Page view, 22
Record view, 23

LayoutWizards, 49, 89
library

selecting, 52
Line

conditioning, 95
properties, 93
Show types, 97
types, 96

Lines per inch. See Output settings
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List
picking, 10
working, 10

� M
Map, 104
Matrix

Column conditions, 83, 87
Column fields, 83, 88

Matrix columns, 82
Memory

insufficient, 124
Menus, 20, 26

Data, 36
Edit, 28
File, 26
Help, 39
Layout, 33, 35
Report, 32
shortcuts, 39
Tools, 37
View, 30
Window, 37

Messages
error, 123
from the server product, 123
other, 124

Microsoft Windows, 1
Missing products, 124
Modifying an existing report definition, 54
More About, 3, 52, 53
Mouse, 45, 58

right button usage, 45

� N
Need help?, 3
Notes. See More About
Null report sheet, 90

� O
Omit, 66
On-line help, 3
Output medium

disk, 117

PC download, 118
printer, 115
workstation, 116

Output queue. See Output settings
Output settings, 114
Override print controls, 94, 115

� P
Page

break, 80
skipping, 80

Page rotation. See Output settings
Page skip tab, 80
Parameter, 10, 69

Definition dialog box, 70
run-time, 69

Parameters tab, 69
PC

downloads, 118
Picking list, 10

filtering, 102
Printer, 115
Printing

report definition layout, 99
Processing modes, 112
Properties, 10

field, 108
line, 93
report, 111
sheet, 90

� Q
QuickFilters, 49, 101

� R
Records, 4
Refining your report

appearance, 89
contents, 62
matix columns, 82

Removing fields from a report definition, 61
Report, 7, 10

menu, 32
properties, 111
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sheet, 10, 90
Specifications, 62

Report definition
adding fields, 58
adding text, 61
creating a new, 50
matrix columns, 82
modifying an existing, 54
print preview, 99
printing the layout, 99
refining the appearance, 89
refining the contents, 62, 82
removing fields, 61
saving, 55
using a data source to create new, 52
using an existing report to create new, 51

Report line types, 96
Report sheet, 10, 90
Report Sheet

adding, 92
Reporting, 7
Reports

internal name, 113
processing modes, 112
security, 111

ReportWizard, 49
Using a, 50

Requirements
System, 13

Router
not loaded, 124

Ruler, 19
Run-time

interface, 119
parameters, 69

� S
Save As, 55
Save output. See Output settings
Saving, 55

your report definition, 55
Security

report access, 111
Select builder

dialog box, 67
Select tab, 66
Select/Omit, 66
Selecting, 66

Server, 27
changing, 122

Server product, 8
Setting

a field’s appearances, 97
the line properties, 93
the sheet properties, 90

Settings
output, 114

Setup types, 15
Sheet, 10

adding, 92
properties, 90

Sheet toolbar, 23
Shortcut menus, 39
Shortcuts

keyboard, 46
menus, 39

Show line types, 31
resizing, 97

Skipping a page, 80
Sort tab, 64
Sorting, 64
Source

data, 9, 106
Specifications, 62

Calculate, 72
Conditions, 76
Page Skip, 80
Parameters, 69
Select, 66
Sort, 64
Summarize, 71

Standard toolbar, 21
Start up dialog, 41
Starting Jacana, 40

for the first time, 41
Status bar, 19
Subset, 10, 107
Summarize tab, 71
Summarizing, 71
Summary values, 71

� T
Tasks

advanced, 101
basic, 49

TCP/IP
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configure, 12
Templates, 121

creating, 121
Text

adding, 61
past right boundary, 61

Tip of the Day, 40
Toolbars, 20

appearance, 25
choosing and locating, 25
data, 24
layout(Page view), 22
layout(Record view, 23
standard, 21

Toolbars, buttons and menus, 20
Tools

menu, 37
Totals, 71
Trouble-shooting, 123

� U
Using

a ReportWizard, 50
fields, 57
filters, 101
QuickFilters, 102
report templates, 121
this guide, 2
your mouse, 45

Using Jacana
Advanced tasks, 101
an introduction, 40
Basic tasks, 49

� V
Version checking, 126
View menu, 30
Views

user, 104

� W
What is Jacana?, 8
What is reporting?, 7
Window

Jacana, 17
layout, 18
menu, 37

Windows
Microsoft, 1

Wizard
Layout, 49, 89
Report, 49

Workfields, 72
Working list, 10
Workstation, 116


